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Linear Algebra: Proof of Euler’s Formula

We now prove the very useful and important Euler formula,

(EQ 1)

First, let us review some properties of the real-valued exponential function,

(EQ 2)

This exponential function has the property that  as .

We now wish to extend this definition to find a complex valued function

(EQ 3)

such that

1.  is single-valued and  is defined
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2. , i.e. 

3. , as  and 

Since , to determine when condition (1) is satisfied, we need to 
define what we mean by . For , the definition of  as 
a limit is familiar, 

(EQ 4)

If both limits exist and return the same finite value, this value is taken to be 
the derivative  at x; otherwise, f(x) is not differentiable at x.

For , we define the derivative  at a point  to be

(EQ 5)

where

(EQ 6)

For this derivative to exist, we must obtain the same finite limiting value 
along all paths . It is sufficient to show that we obtain the same limit-
ing value along the two paths (I) and (II) in Figure 1.
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df
dz
-----

ẑ
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Linear Algebra: Proof of Euler’s Formula
FIGURE 1. Paths (I) and (II) in the complex plane used to prove that df/dz 
exists at a point

If , let us write  as

(EQ 7)

where u and w are both real-valued, differentiable functions.

Along path (I), the path of constant imaginary part of z,

(EQ 8)

Therefore, in the limit ,

(EQ 9)
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Along path (II), the path of constant real part of z,

(EQ 10)

so that when ,

(EQ 11)

For  to exist, these two limiting values of the derivative must be equal,

(EQ 12)

This yields the Cauchy-Riemann equations that must be satisfied for  to 

exist, i.e. for  to be analytic,

(EQ 13)

To find an analytic exponential function for complex numbers, we write 

 as 

 (EQ 14)

and find the real functions  that satisfy the Cauchy-Riemann 
equations and the defining equation for the exponential function,

(EQ 15)
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Linear Algebra: Proof of Euler’s Formula
Along path (I), 

(EQ 16)

which yields the two conditions

(EQ 17)

The first is satisfied if

(EQ 18)

Using the second Cauchy-Riemann equation, the second condition in (EQ 
17) becomes

(EQ 19)

Differentiation with respect to b yields

(EQ 20)

Using the first Cauchy-Riemann equation, we obtain

(EQ 21)

We then use the real part of the path (I) limit, , to obtain

(EQ 22)

Substituting  yields
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(EQ 23)

This differential equation has the general solution

(EQ 24)

therefore

(EQ 25)

We next use (EQ 19) to obtain

(EQ 26)

Therefore, to satisfy the Cauchy-Riemann equations and possess the proper-
ties of the exponential function, we must have

(EQ 27)

Finally, we must have , so with  we have

(EQ 28)

requiring  and ; so that for ,

(EQ 29)

For , this yields the Euler formula, 

(EQ 30)
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Linear Algebra: Floating point real number representation and round-off errors
Linear Algebra: Floating point real number 
representation and round-off errors

In the algorithm for partial pivoting, we perform a pivot not just when the 
diagonal element is zero, but whenever the diagonal element is not greater 
than all values in the column below. This may seem like wasted effort; how-
ever, there is a good reason to do so. Pivoting in this case makes the elimi-
nation algorithm more stable with respect to the round-off errors that occur 
whenever we store real numbers in the memory of a digital computer.

Floating point number representation

If we were to look at the memory within a computer, we would find data 
represented digitally as a sequence of 0s and 1s

Each individual 0 or 1 location in memory is called a bit, and each set of 
eight consecutive bits is called a byte. To store a real number (such as 3.273) 
in memory, we need to represent it in such a binary format. This is done typ-
ically using floating point notation. Let f be a real number that we want to 
store in memory. To do so, we must approximate it as some representation 

value  that we can express in binary format as

(EQ 31)

t is a positive integer fixed in the representation system. Each  takes a 

value of 0 or 1, and is stored in digital memory as a single bit. e is a integer 
exponent in the range

(EQ 32)

that is also stored in binary format, e.g. by allocating a byte,

(EQ 33)

01001011 00001101 00000001 00010110
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with the sign of e determined by the eighth bit  (say if , ; else 

). To represent the integer , we would have

The upper bound  occurs when , 

(EQ 34)

In general,  and , where  is the number of bits allocated 
to store each e. The values of t and  are fixed in the definition of our sys-
tem of binary representation. For each real number f, the floating-point rep-
resentation  consists of the bits allocated to store the values of , 

e, and the sign of f. To maximize the efficiency of storing data, we may 
adjust e so that , in which case a binary representation with  

is

(EQ 35)

What real number does this represent? First, we compute the exponent inte-
ger,

(EQ 36)

In decimal notation,

(EQ 37)

What are the smallest and largest magnitude real numbers that can be rep-
resented in memory for a given  and ?
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Linear Algebra: Floating point real number representation and round-off errors
The smallest magnitude m of a real number that can be represented occurs 
when only  is non-zero and ,

(EQ 38)

so that

(EQ 39)

The largest magnitude M that can be represented occurs when all  and 

,

(EQ 40)

so that

(EQ 41)

In the last equality we have used the identity for a geometric progression,

(EQ 42)

For given  and , we can store representation values in the range

(EQ 43)

It is common to represent real numbers with  by “0” and those with 

 by “NaN”, i.e. “Not a Number”. We can increase the breadth of this 
range by increasing the values of  and ; however, the number of bits, 

, necessary to store each real number also increases. A common sys-
tem is 32-bit single precision with ,  and , 
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, . In 64-bit double precision, the memory alloca-
tion is doubled with , . It is important to note that the actual 
representation system labeled as single or double precision varies from one 
machine to another.

Propagation of round-off errors

An important point is that when we wish to store a real number f in memory, 
in general it cannot be exactly represented by a finite set of bits in floating 

point notation. We must therefore approximate it by some value  that can 
be represented in memory,

 (EQ 44)

The difference between the “true” value f and the representation value  is 
called the round-off error, 

(EQ 45)

For binary representation of a number f with , the magnitude of 
the round-off error is

(EQ 46)

where we define the machine precision (MATLAB command eps) as

(EQ 47)

We write the round-off error as

(EQ 48)

where  is some number on the order of one. We write the representation 

value  as
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Linear Algebra: Floating point real number representation and round-off errors
(EQ 49)

where the mantissa,

(EQ 50)

is also of order one. We then characterize the relative round-off error in our 
representation of f as

(EQ 51)

As  is generally about on the order of one, eps determines the relative 

amount of error when representing real numbers in floating point notation. 

If , as is usually the case, ; that is, when storing a real number 
in memory, we can represent it to high relative precision, although there is 
in general some finite amount, though small, of round-off error.

Even though relative round-off errors are initially quite small, we may per-
form a sequence of operations on the set of representation values that store 
the data for our problem that increase (magnify) the initial round-off errors 
until they do become significant.

For example, let us take the difference between two similar, but large, num-
bers,

(EQ 52)

We see that . Let us write each real number as its representation 
plus some round off error,

(EQ 53)

Likewise the difference is

(EQ 54)
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Thus, the representation error in the value of  after forming it from the 
difference of the representations of  and  is

(EQ 55)

Here  denotes the cumulative round-off error of a quantity , which 
takes into account all sources of round-off error that feed into its representa-

tion  through the operations that we have performed to date. Let us write

(EQ 56)

The relative cumulative round-off error of  is then

(EQ 57)

For the case of , ; that is, two numbers 
that are very similar, we have , and

(EQ 58)

In general, the difference  is expected to on the order of one. However, 

if  and  are very close, we do know that , and thus

(EQ 59)

When subtracting two real numbers  and  that are very close in value, the 
relative representation error for the difference , computed from the rep-
resentations of  and , may be far larger than the original round-off errors 
in either  or .
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Such a subtraction therefore has poor error propagation, and the accuracy 
of the stored representation values becomes less each time this operation is 
performed. We wish to design our algorithms so that the cumulative round-
off errors do not grow larger, and ideally decay to zero. Once the relative 
cumulative errors grow to the order of one, the algorithm may crash as the 
representation values stored in memory are highly inaccurate.

Favorable error propagation with partial pivoting

To design algorithms with favorable error propagation, we must consider 
what happens to cumulative round-off error when performing the operation

(EQ 60)

As we really perform the operation on the floating point representations, the 
values stored in memory transform as

(EQ 61)

 is new round-off error introduced when storing the result in memory,

(EQ 62)

The cumulative round-off error of a transforms during  as

(EQ 63)

Assuming the best case that , we have

(EQ 64)

We note that  and  may be positive or negative, and so the fact 

that they are subtracted from  is irrelevant.
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crd b( ) enew
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What is important, is that if , the contribution from  to the new 
value of  is amplified, so that we have poor error propagation.

Therefore, when designing algorithms that include scalar operations of the 
form , we should ensure that  and so make the algorithm 
stable with respect to the propagation of error.

We now can see why we perform partial pivoting during Gaussian elimina-
tion, even if the diagonal element in the column is non-zero. To eliminate 
the value at the  position, we perform a number of scalar operations

(EQ 65)

If we first perform a partial pivot, if needed, to ensure that  has the largest 

magnitude of any element at or below the diagonal in column #i, then all 
. 

Therefore, partial pivoting produces a Gaussian elimination algorithm that 
is numerically stable with respect to the propagation of error, at least as 
long as the elements of A are of comparable magnitude.

We add this qualification, because if the elements of  are dramatically dif-
ferent, especially across any given row, we then have scalar operations 
involving numbers of vastly different magnitudes that are not favorable for 
the propagation of error. If we use full pivoting, in which we also swap col-
umns, we can further improve the error propagation properties. For most 
systems, however, partial pivoting is sufficient.

Linear Algebra: Computing the FLOPs necessary 
to perform Gaussian elimination and backward 
substitution

Let us now determine the exact numbers of FLOPs required for elimination, 
, and backward substitution, .

λ 1> crd b( )
crd a( )

a a λb–← λ 1<
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ajk ajk λ jiaik–← λ j i aji aii⁄=

aii

λ j i 1≤

A
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Linear Algebra: Computing the FLOPs necessary to perform Gaussian elimination and 
First, consider elimination. Let  be the number of FLOPs required to put 

all zeros below the diagonal in the first column. To place a zero at (2,1), we 
perform a row operation involving  FLOPS,

 (EQ 66)

To place all zeros in the remainder of column 1, we need to perform another 
 row operation to place zeros at . Each row oper-

ation requires  FLOPs. The number of FLOPS required to place zeros 
below the diagonal in the first column is

(EQ 67)

To place zeros below the diagonal in the second column, we perform  
row operations, each of which requires two fewer FLOPs than those for the 
first column. The total number of FLOPs required to eliminate the lower tri-
angular elements in the second column is

(EQ 68)

In general, to place zeros below the diagonal in column #i, we must perform 
 row operations, each involving  FLOPs, so that the number 

of FLOPs required for column #i is

(EQ 69)

The total number of FLOPs required to put the system in triangular form is

(EQ 70)

In the limit , we can approximate this sum by an integral,

v1
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1 FLOP calculate λ21⇔
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(EQ 71)

Using a change of variable , we have

(EQ 72)

The number of FLOPs required for backward substitution is

(EQ 73)

Therefore, for large systems of equations, when the number of calculations 
required to solve the system is a concern, .

For large systems, the CPU time required to perform backward substitution 
is trivially small compared to the effort required to transform the system 
into upper triangular form. The overall number of FLOPs required to solve 

the system by Gaussian elimination is essentially .

Linear Algebra: More on matrix determinants

We now provide a more detailed discussion of matrix determinants, and in 
particular provide some reasons why the proposed functional form is a rea-
sonable one. In addition, proofs of some of the properties of determinants 
and a demonstration of expansion by minors are provided.

We define the determinant of a square  matrix A as
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∫≈=
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N
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∫≈ 2 y
2

yd
0

N

∫
2
3
---N
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∫≈d

1
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∫≈
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N N×
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Linear Algebra: More on matrix determinants
(EQ 74)

If ; that is, if A is nonsingular, then  has a unique solution 

for all . Otherwise, if ; that is, if A is singular, then no 
unique solution to  exists (either there are no solutions or an infinite 
number of them).

We wish to find a formula to compute from the matrix A the scalar value of 
the determinant that satisfies the above definition. To do so, we first identify 
a number of characteristics that this determinant function must have to be a 
reliable measure of singularity.

Characteristic # 1

Let us we multiply any equation in our linear system, say the second, by 
some non-zero real scalar ,

(EQ 75)

If  has a unique solution, certainly the transformed, equivalent one 
does as well. Such a transformation should not change whether the determi-
nant is zero or not.

Characteristic #2

Since the existence of a solution to  does not depend upon the order 
in which we write the equations, we should be able to swap any rows in the 
matrix A without affecting whether the determinant is zero or not.

det A( ) A
c 0≠  if KA, 0=

0  if w KA∈ w 0≠,∃,



= =

det A( ) 0≠ Ax b=

b ℜ N∈ det A( ) 0=

Ax b=

c 0≠

a11 a12 … a1N

a21 a22 … a2N

: : :

aN1 aN2 … aNN

a11 a12 … a1N

ca21 ca22 … ca2N

: : :

aN1 aN2 … aNN

⇒

b1

b2

:

bN

b1

cb2

:

bN

⇒

Ax b=

Ax b=
Beers, Numerical Methods in Chemical Engineering 17
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Characteristic #3

Similarly, we should be able to modify the system  by relabeling the 
unknowns; for example, by exchanging  which corresponds to swap-

ping the  and  columns of A. This should not affect whether or not the 
determinant is zero.

Characteristic #4

We can perform any elementary row operation  with  to the 
augmented matrix  to obtain a new equivalent system . If 

, then  and if , then .

Characteristic #5

If the matrix product  is to be nonsingular, i.e. there is a unique solu-
tion to ; then there must be a unique v such that  and also a 
unique x such that . Thus, for  to be nonsingular, both A and 
B must be nonsingular.

Characteristic #6

If any two rows of A are identical, or simply differ by a scalar factor c, the 
equations that they represent are dependent and it is possible to convert the 
system into an equivalent one with a row containing only zeros. We there-
fore must have .

Characteristic #7

Similarly, if any two columns of A, say the  and the , are multiples of 
each other, i.e. , we can write any equation #m in the system as,

(EQ 76)

Ax b=

xj xk⇔

j
th

k
th

k k c j×+← c 0≠
A b,( ) A′ b ′,( )

det A( ) 0≠ det A'( ) 0≠ det A( ) 0= det A'( ) 0=

C AB=

Cx b= Av b=

Bx v= C AB=

det A( ) 0=

j
th

k
th

amj camk=

am1x1 … amjxj … amkxk … amNxN+ + + + + + bm=

am1x1 … camkxj … amkxk … amNxN+ + + + + + bm=

am1x1 … 0( )xj … amk xk cxj+( ) … amNxN+ + + + + + bm=
Beers, Numerical Methods in Chemical Engineering



Linear Algebra: More on matrix determinants
We thus can make any change to x of the form

(EQ 77)

without changing the value of Ax. Therefore, there can be no unique solu-
tion to  and we must have .

We have listed some properties that  must have to be a reliable mea-
sure of singularity, and now show that the definition in the text satisfies 
them,

(EQ 78)

Expansion by minors of a 3 x 3 matrix

Using (EQ 78), we now demonstrate expansion by minors for the determi-
nant of a  matrix,

(EQ 79)

We rearrange the equation for the  matrix by splitting the summation 
over ,

(EQ 80)

If either  or , then , so the first sum is

xj xj ∆xj+← xk xk c∆xj–← xm xm m j k,≠,←

Ax b= det A( ) 0=

det A( )

det A( ) … εi1 i2 … iN, , , ai1 1, ai2 2, …aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

3 3×

det A( )
a11 a12 a13

a21 a22 a23

a31 a32 a33

εi1 i2 i3, , ai1 1, ai2 2, ai3 3,

i3 1=

3

∑
i2 1=

3

∑
i1 1=

3

∑= =

3 3×
i1

det A( ) ε1 i2 i3, , a11ai2 2, ai3 3,

i3 1=

3

∑
i2 1=

3

∑ εi1 i2 i3, , ai1 1, ai2 2, ai3 3,

i3 1=

3

∑
i2 1=

3

∑
i1 1=

i1 1≠

3

∑+=

i2 1= i3 1= ε1 i2 i3, , 0=
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(EQ 81)

We now split the summation over ,

(EQ 82)

The sum multiplying  is

(EQ 83)

Finally, we split the summation over ,

(EQ 84)

In the final sum, we note that if none of  equals one, then at least 

two of them must be equal, and  for every term in the sum. The 

sum multiplying  is

ε1 i2 i3, , ai2 2, ai3 3,

i3 1=

3

∑
i2 1=

3

∑ ε1 2 3, , a22a33 ε1 3 2, , a32a23+
a22 a23

a32 a33

= =

i2

det A( ) a11
a22 a23

a32 a33

a12 εi1 1 i3, , ai1 1, ai3 3,

i3 1=

3

∑
i1 1=

i1 1≠

3

∑+=

εi1 i2 i3, , ai1 1, ai2 2, ai3 3,

i3 1=

3

∑
i2 1=

i2 1≠

3

∑
i1 1=

i1 1≠

3

∑+

a12

εi1 1 i3, , ai1 1, ai3 3,

i3 1=

3

∑
i1 1=

i1 1≠

3

∑ ε2 1 3, , a21a33 ε3 1 2, , a31a23+
a21 a23

a31 a33

–= =

i3

det A( ) a11
a22 a23

a32 a33

a12
a21 a23

a31 a33

– a13 εi1 i2 1, , ai1 1, ai2 2,

i2 1=

i2 1≠

3

∑
i1 1=

i1 1≠

3

∑+=

εi1 i2 i3, , ai1 1, ai2 2, ai3 3,

i3 1=

i3 1≠

3

∑
i2 1=

i2 1≠

3

∑
i1 1=

i1 1≠

3

∑+

i1 i2 i3, ,{ }

εi1 i2 i3, , 0=

a13
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(EQ 85)

Therefore, the determinant of a  matrix can be written as an expansion 
in minors,

(EQ 86)

General properties of the determinant function

We now provide proofs for the general properties of determinants. From 
these properties, it is shown that the formula for the determinant proposed 
above satisfies the desired characteristics that we have identified.

Property I

The determinant of a  real matrix A equals that of its transpose, .

Proof:

The determinant of , with , is

(EQ 87)

For every ordered set  that is a permutation of , there 

exists another permutation  such that

εi1 i2 1, , ai1 1, ai2 2,

i2 1=

i2 1≠

3

∑
i1 1=

i1 1≠

3

∑ ε2 3 1, , a21a32 ε3 2 1, , a31a22+
a21 a22

a31 a32

= =

3 3×

det A( ) a11
a22 a23

a32 a33

a12
a21 a23

a31 a33

– a13
a21 a22

a31 a32

+=

N N× A
T

A
T

ajk
T

akj=

det AT( ) … εi1 i2 … iN, , , ai1 1,
T ai2 2,

T …aiN N,
T

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

det A
T( ) … εi1 i2 … iN, , , a1 i1, a2 i2, …aN iN,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

i1 i2 … iN, , ,( ) 1 2 … N, , ,( )

j1 j2 … jN, , ,( )
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(EQ 88)

Let us reorder the product  by a sequence of exchanges, to 

put first the element from column 1, next the element from column 2, etc., 
to obtain finally . During this sequence of exchanges, the row 

indices are transformed as  and the column indices 

are transformed as . Therefore, both  

and  are of the same parity and

(EQ 89)

Thus, we can write the determinant of  as

(EQ 90)

Q.E.D.

Property II

If every element in a row (column) of A is zero, .

Proof:

Let every element in column #m of A be zero. In the formula for ,

(EQ 91)

every term in the summation contains in its product  

an element of column #m that is zero. Therefore, every term in the summa-

tion is zero, and . From property I, , we see that 

a1 i1, a2 i2, …aN iN, aj1 1, aj2 2, …ajN N,=

a1 i1, a2 i2, …aN iN,

aj1 1, aj2 2, …ajN N,

1 2 … N, , ,( ) j1 j2 … jN, , ,( )→

i1 i2 … iN, , ,( ) 1 2 … N, , ,( )→ j1 j2 … jN, , ,( )

i1 i2 … iN, , ,( )

εi1 i2 … iN, , , εj1 j2 … jN, , ,=

A
T

det A
T( ) … εj1 j2 … jN, , , aj1 1, aj2 2, …ajN N,

jN 1=

N

∑
j2 1=

N

∑
j1 1=

N

∑ det A( )= =

det A( ) 0=

det A( )

det A( ) … εi1 i2 … iN, , , ai1 1, ai2 2, …aim m, …aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

ai1 1, ai2 2, …aim m, …aiN N,

det A( ) 0= det A
T( ) det A( )=
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Linear Algebra: More on matrix determinants
if every element in row #m of A is zero, every element in column #m of  

will be zero, and .

Q.E.D.

Property III

If every element in a row (column) of a matrix A is multiplied by a scalar c 
to form a matrix B, then .

(EQ 92)

Property IV

If two rows (columns) of A are interchanged to form a matrix B, 
.

Proof:

Let us interchange columns #r and #s, with ,

(EQ 93)

The determinant of B is

(EQ 94)

A
T

det A
T( ) 0 det A( )= =

det B( ) c det A( )×=

A

a11 a12 … a1N

: : :

am1 am2 … amN

: : :

aN1 aN2 … aNN

= B

a11 a12 … a1N

: : :

cam1( ) cam2( ) … camN( )
: : :

aN1 aN2 … aNN

=

det B( ) det A( )–=

r s<

A

a11 … a1r … a1s … a1N

a21 … a2r … a2s … a2N

: : : :

aN1 … aNr … aNs … aNN

= B

a11 … a1s … a1r … a1N

a21 … a2s … a2r … a2N

: : : :

aN1 … aNs … aNr … aNN

=

det B( ) … εi1 … ir … is … iN, , , , , , ai1 1, …air s, …ais r, …aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=
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If we exchange  and  in the permutation,

(EQ 95)

so that we way write  as

(EQ 96)

We now relabel the dummy indices, switching everywhere ,

(EQ 97)

Therefore, . That the same property holds for exchanging 

two rows follows from .

Q.E.D.

Property V

If two rows (columns) of A are the same, then .

Proof:

Let B be the matrix that is obtained by switching the two identical rows or 
columns of A. By property IV, , but since the two 
exchanged rows (columns) are identical, , and . 
Therefore, we must have .

Q.E.D.

ir is

εi1 … ir … is … iN, , , , , , εi1 … is … ir … iN, , , , , ,–=

det B( )

det B( ) … εi1 … is … ir … iN, , , , , , ai1 1, …air s, …ais r, …aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑–=

ir is⇔

det B( ) … εi1 … ir … is … iN, , , , , , ai1 1, …ais s, …air r, …aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑–=

det B( ) det A( )–=

det A
T( ) det A( )=

det A( ) 0=

det B( ) det A( )–=

B A= det B( ) det A( )=

det A( ) 0=
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Property VI

If  is the row vector for row #m of matrix A, and we decompose this row 
vector as

(EQ 98)

to form the matrices

(EQ 99)

then

(EQ 100)

Proof:

We write the determinant of A as

(EQ 101)

a m( )

a m( ) b m( ) d m( )+=

A

-----a 1( )-----

:

-----a m( )-----

:

-----a N( )-----

= B

-----a 1( )-----

:

-----b m( )-----

:

-----a N( )-----

= D

-----a 1( )-----

:

-----d m( )-----

:

-----a N( )-----

=

det A( ) det B( ) det D( )+=

det A( ) … εi1 i2 … iN, , , ai1 1, ai2 2, … bim m, dim m,+( )…aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

… εi1 i2 … iN, , , ai1 1, ai2 2, … bim m,( )…aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

… εi1 i2 … iN, , , ai1 1, ai2 2, … dim m,( )…aiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑+

det A( ) det B( ) det D( )+=
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Property VII

If a matrix B is obtained from A by adding c times one row (column) of A to 
another row (column) of A, then . That is, elementary row 
operations do not change the value of the determinant.

Proof:

Let us define the following matrices in terms of their row vectors,

(EQ 102)

By property IV, . By property III, 
, so that . But, since two rows 

of E are the same, . Therefore, .

Q.E.D.

det B( ) det A( )=

A

---a
1( )

---

:

---a
j( )

---

:

---a
k( )

---

:

---a N( )
---

= B

---a
1( )

---

:

---a
j( )

---

:

--- a
k( )

ca
j( )

+[ ] ---
:

---a N( )
---

=

D

---a
1( )

---

:

---a
j( )

---

:

--- ca
j( )[ ] ---

:

---a
N( )

---

= E

---a
1( )

---

:

---a
j( )

---

:

---a
j( )

---
:

---a
N( )

---

=

det B( ) det A( ) det D( )+=

det D( ) c det E( )×= det B( ) det A( ) c det E( )×+=

det E( ) 0= det B( ) det A( )=
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Property VIII

(EQ 103)

Proof:

We demonstrate this property for  matrices. Expansion by minors may 
be used to show that this property extends to matrices of higher dimension. 
For the  matrices

(EQ 104)

we use  to write  as

(EQ 105)

Multiplying the sums yields

(EQ 106)

Collecting terms gives

(EQ 107)

Canceling out the zero terms and collecting the remainder yields

det AB( ) det A( ) det B( )×=

2 2×

2 2×

A
a11 a12

a21 a22

= B
b11 b12

b21 b22

= C AB=

cij ai1b1j ai2b2 j+= det C( ) c11c22 c21c12–=

det C( ) a11b11 a12b21+( ) a21b12 a22b22+( )=

a21b11 a22b21+( ) a11b12 a12b22+( )–

det C( ) a11a21( ) b11b12( ) a11a22( ) b11b22( )+=

a12a21( ) b21b12( ) a12a22( ) b21b22( )+ +

a21a11( ) b11b12( )– a21a12( ) b11b22( )–

a22a11( ) b21b12( )– a22a12( ) b21b22( )–

det C( ) a11a22( ) b11b22 b21b12–( )=

a11a21( ) b11b12 b11b12–( )+

a12a21( ) b21b12 b11b22–( )+

a12a22( ) b21b22 b21b22–( )+
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(EQ 108)

Property IX

If A is upper triangular or lower triangular,  equals the product of the 
elements on the principal diagonal, .

Proof:

Let us consider a lower triangular matrix

(EQ 109)

whose determinant is

(EQ 110)

Among the terms in this summation, there is one with , , etc. 

with . All other terms in the summation must have 

at least one off-diagonal element. For any term with no two indices alike 
(and thus ), if there is an element from below the diagonal in the 

product, there also must be one from above the diagonal. Since all elements 
above the diagonal are zero, the only non-zero product of elements contrib-
uting to  is that containing the diagonal elements, and

(EQ 111)

Similar reasoning holds for an upper triangular matrix.

det C( ) a11a22 a12a21–( ) b11b22 b12b22–( )=

det C( ) det AB( ) det A( ) det B( )×= =

det A( )
det A( ) a11 a22× … aNN××=

L

L11

L21 L22

: : .

LN1 LN2 … LNN

=

det L( ) … εi1 i2 … iN, , , Li1 1, Li2 2, …LiN N,

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

i1 1= i2 2=

εi1 i2 … iN, , , ε1 2 … N, , , 1= =

εi1 i2 … iN, , , 0≠

det L( )

det L( ) L11 L22× …× LNN×=
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Nonlinear algebraic systems: Formal convergence properties of Newton’s method for 
Q.E.D.

The following table shows how the desired characteristics that we have 
required for  follow from the properties stated above.

Nonlinear algebraic systems: Formal convergence 
properties of Newton’s method for systems of 
multiple equations

As is the case with a single equation, Newton’s method for multiple equa-
tions converges quadratically when the current estimate is in the close vicin-

ity of the solution; however, the proof is somewhat more involved. Let  
be our current estimate of the solution , with . Let us assume that 

 and  are both within some convex region , and that within ,  

is continuously differentiable. By convex, we mean that  has the property 
that any line segment connecting two points in  lies completely in . An 
example of a convex region would be a hypersphere of some specified 

radius about  that contains .

We define the current error vector as

(EQ 112)

det A( )

characteristic # 1 property III⇐
characteristic # 2 property IV⇐
characteristic # 3 property IV⇐
characteristic # 4 property VII⇐
characteristic # 5 property VIII⇐

characteristic # 6 properties II, V⇐
characteristic # 7 properties II, V⇐

x
k[ ]

xs f xs( ) 0=

x k[ ] xs Ω Ω f x( )

Ω
Ω Ω

xs x
k[ ]

ε k[ ] x k[ ] xs–= x k[ ] xs ε k[ ]+=
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Because  is continuously differentiable in , we can define the Jaco-

bian matrix for all points along the line segment connecting  and ; that 

is, for every , we can compute the Jacobian elements

(EQ 113)

From the Jacobian, we compute the derivative of each component of the 
function vector with respect to , the fractional path length along the line 

segment running from  at  to  at . Using the chain rule

(EQ 114)

and the fact that along the line segment ,

(EQ 115)

we have

(EQ 116)

The variation in  over the line segment connecting  and  is obtained 

from the path integral

(EQ 117)

Since at the solution, , this yields

f x( ) Ω

xs x
k[ ]

s 0 1,[ ]∈

Jmn xs sε k[ ]+( )
xn∂
∂fm

xs sε k[ ]+

=

s

xs s 0= x
k[ ]

s 1=

sd

dfi

x1∂
∂fi

sd

dx1

x2∂
∂fi

sd

dx2 …
xN∂
∂fi

sd

dxN+ + +=

x xs sε k[ ]
+=

sd

dxj εj
k[ ]=

sd

dfi Ji1ε1
k[ ]

Ji2ε2
k[ ] … JiNεN

k[ ]+ + + Jε k[ ]( )i= =

fi xs x
k[ ]

fi x k[ ]( ) fi xs( )–
sd

dfi

xs sε k[ ]+

sd
0

1

∫ J xs sε k[ ]+( )ε k[ ][ ] i sd
0

1

∫= =

fi xs( ) 0=
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Nonlinear algebraic systems: Formal convergence properties of Newton’s method for 
(EQ 118)

In Newton’s method, we update the estimate of the solution by the rule

(EQ 119)

Therefore, this relation becomes

(EQ 120)

The update vector is related to the error vectors by

(EQ 121)

therefore,

(EQ 122)

Assuming that the Jacobian matrix is non-singular at ,

(EQ 123)

As the quantity within the {} on the right is merely a matrix, we use the con-
cept of a matrix norm,

f x k[ ]( ) J xs sε k[ ]+( )ε k[ ]
sd

0

1

∫=

J
k[ ] ∆x k[ ]

f x k[ ]( )–=

J
k[ ] ∆x k[ ]– J xs sε k[ ]+( )ε k[ ]

sd
0

1

∫=

∆x k[ ] x k 1+[ ] x k[ ]– ε k 1+[ ] ε k[ ]–= =

J k[ ] ε k 1+[ ] ε k[ ]–[ ]– J xs sε k[ ]+( )ε k[ ] sd
0

1

∫=

J
k[ ] ε k 1+[ ]– J xs sε k[ ]+( ) J

k[ ]–[ ]ε k[ ]
sd

0

1

∫=

J
k[ ] ε k 1+[ ]– J xs sε k[ ]+( ) J

k[ ]–[ ] sd
0

1

∫ 
 
 

ε k[ ]=

x
k[ ]

ε k 1+[ ]– J
k[ ]( )

1–
J xs sε k[ ]+( ) J

k[ ]–[ ] sd
0

1

∫ 
 
 

ε k[ ]=
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(EQ 124)

and the identities

(EQ 125)

to write

(EQ 126)

We now make the additional assumption that not only is  continuous in 
, but that it is also Lipschitz continuous; that is, for some finite ,

(EQ 127)

so that,

(EQ 128)

We therefore find that

(EQ 129)

This establishes quadratic convergence, with rapid reduction of the error 
within a few iterations when the current estimate is sufficiently close to the 
solution. Although we have proved that such a quadratic region exists, in 
practice, we may have to be very close to the solution to observe it.

A maxv 0≠
Av
v

-----------≡

Av A v≤
ABv A Bv A B v≤ ≤

ε k 1+[ ]
J

k[ ]( )
1–

J xs sε k[ ]+( ) J
k[ ]–[ ] sd

0

1

∫ ε k[ ]≤

J x( )
Ω L

J x( ) J y( )– L x y–≤ x y, Ω∈∀

J xs sε k[ ]+( ) J
k[ ]–[ ] sd

0

1

∫ L s ε k[ ]≤

ε k 1+[ ]
L s J

k[ ]( )
1–

ε k[ ] 2
≤
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Matrix eigenvalue analysis: Proof that the trace equals the sum of eigenvalues
Matrix eigenvalue analysis: Proof that the trace 
equals the sum of eigenvalues

We now show that the trace of a real matrix A equals the sum of its eigen-
values,

(EQ 130)

We first use the property  to write

(EQ 131)

We now write this determinant explicitly,

(EQ 132)

We isolate the contribution from the term with ,

(EQ 133)

 is some polynomial of at most degree . As , 

(EQ 134)

Actually,  must be a polynomial of at most degree , because for 
any possible term contributing a non-zero amount to , no two 

 be identical. Therefore, any off-diagonal element of  in 

such a term must be paired with another off-diagonal element. Thus, there 

can be no term in  proportional to , as such a term must have only 
one off-diagonal element. As the degree of  is then at most , we 
write it as . We next write

tr A( ) a11 a22 … aNN λ1 λ2 … λN+ + +=+ + +=

det A( ) 1–( )Ndet A–( )=

det A λ I–( ) 1–( )N
det λ I A–( )=

det A λ I–( ) 1–( )N … εi1 i2 … iN, , ,( ) λδi1 1, ai1 1,
–( )… λδiN N, aiN N,–( )

iN 1=

N

∑
i2 1=

N

∑
i1 1=

N

∑=

i1 1= i2 2= … iN N=, , ,

det A λ I–( ) 1–( )N ε1 2 … N, , , λ a11–( ) λ a22–( )… λ aNN–( ) R λ( )+[ ]=

R λ( ) N 1– ε1 2 … N, , , 1=

det A λ I–( ) 1–( )N λ a11–( ) λ a22–( )… λ aNN–( ) R λ( )+[ ]=

R λ( ) N 2–

R λ( )
i1 i2 … iN, , ,{ } A λ I–( )

R λ( ) λN 1–

R λ( ) N 2–

RN 2– λ( )
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(EQ 135)

where  is some polynomial of degree . (EQ 134) then becomes,

(EQ 136)

If  are the roots of the characteristic polynomial, we can write

(EQ 137)

where  is again some polynomial of degree .

Since (EQ 136) and (EQ 137) both represent the same polynomial, compar-

ing the coefficient that multiplies  shows that the trace is equal to the 
sum of the eigenvalues,

(EQ 138)

Q.E.D.

Matrix eigenvalue analysis: Proof of Gershgorin’s 
theorem

We now prove Gershgorin’s theorem, starting first with the following:

Theorem:

If B is an arbitrary  matrix, then for all eigenvalues  of a  matrix 
A,

λ a11–( ) λ a22–( )… λ aNN–( )

λN a11 a22 … aNN+ + +( )λN 1–– SN 2– λ( )+=

SN 2– λ( ) N 2–

det A λ I–( ) 1–( )N λN a11 a22 … aNN+ + +( )λN 1–– SN 2– λ( ) RN 2– λ( )+ +[ ]=

λ1 … λN, ,

det A λ I–( ) 1–( )Ndet λ I A–( ) 1–( )N λ λ 1–( ) λ λ 2–( )… λ λN–( )[ ]= =

det A λ I–( ) 1–( )N λN λ1 λ2 … λN+ + +( )λN 1–– TN 2– λ( )+[ ]=

TN 2– λ( ) N 2–

λN 1–

tr A( ) λ1 λ2 … λN+ + +=

N N× λ N N×
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Matrix eigenvalue analysis: Proof of Gershgorin’s theorem
(EQ 139)

unless  is also an eigenvalue of B.

Proof:

Let  be an eigenvector for , , then

(EQ 140)

If  is not an eigenvalue of B, , and we may write

(EQ 141)

We now take the norm of both sides,

(EQ 142)

and apply the definition of a matrix norm,

(EQ 143)

We now use the general property  to obtain (EQ 139).

Q.E.D.

We use this theorem to prove Gershgorin’s theorem by selecting

(EQ 144)

for which

1 λ I B–( ) 1–
A B–( ) λ I B–( ) 1–

A B–≤ ≤

λ

w λ Aw λw=

A B–( )w λ I B–( )w=

λ det λ I B–( ) 0≠

λ I B–( ) 1– A B–( )w w=

λ I B–( ) 1– A B–( )w w=

λ I B–( ) 1–
A B–( )w

w
---------------------------------------------------- 1 λ I B–( ) 1– A B–( )≤=

AB A B≤

B diag A( )

a11

a22

.

aNN

= =
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(EQ 145)

Inverting this diagonal matrix,

(EQ 146)

and noting that

(EQ 147)

we obtain by matrix multiplication

(EQ 148)

Selecting the infinity norm for , the corresponding matrix norm is

λ I B

λ a– 11

λ a– 22

.

λ a– NN

=–

λ I B–( ) 1–

λ a– 11( ) 1–

λ a– 22( ) 1–

.

λ a– NN( ) 1–

=

A B–( )

0 a12 … a1N

a21 0 … a2N

: : . :

aN1 aN2 … 0

=

λ I B–( ) 1–
A B–( ) =

0 λ a– 11( ) 1–
a12 λ a– 11( ) 1–

a13 … λ a– 11( ) 1–
a1N

λ a– 22( ) 1–
a21 0 λ a– 22( ) 1–

a23 … λ a– 22( ) 1–
a2N

: : : :

λ a– NN( ) 1–
aN1 λ a– NN( ) 1–

aN2 λ a– NN( ) 1–
aN3 … 0

v
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Matrix eigenvalue analysis: Proof of Gershgorin’s theorem
(EQ 149)

where in the last equality we have chosen  such that for 

each , . We now apply this matrix norm to 

, that has the elements

(EQ 150)

to yield

(EQ 151)

From (EQ 139), , we have

(EQ 152)

Thus, for each eigenvalue  of A, there must be some  such that

(EQ 153)

A ∞ maxv 0≠
maxj Av( )j{ }

maxj vj{ }
---------------------------------- maxv 0≠

maxj ajkvk

k 1=

N

∑
 
 
 
 
 

maxj vj{ }
-------------------------------------------- maxj ajk

k 1=

N

∑
 
 
 
 
 

= = =

v c± c± … c±
T

=

j 1 2 … N, , ,= ajkvk 0>

λ I B–( ) 1–
A B–( )

λ I B–( ) 1– A B–( )[ ] jk

0 if j, k=

λ a– jj( ) 1–
ajk if j k≠,




=

λ I B–( ) 1– A B–( ) ∞ maxj λ a– j j( ) 1– ajk

k 1=

N

∑
 
 
 
 
 

maxj
ajk

λ a– j j

------------------

k 1=

k j≠

N

∑
 
 
 
 
 
 
 

= =

λ I B–( ) 1–
A B–( ) 1≥

maxj
ajk

λ a– j j

------------------

k 1=

k j≠

N

∑
 
 
 
 
 

1≥

λ j 1 N,[ ]∈

λ a– j j
1–

ajk 1≥
k 1=

k j≠

N

∑
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This proves Gershgorin’s theorem,

(EQ 154)

Q.E.D.

Matrix eigenvalue analysis: Applications in 
Quantum Mechanics

In chapter 3 of the text, we demonstrate how eigenvalue analysis is used to 
compute the energy and wavefunction of a single-electron system in quan-
tum mechanics. This section provides some further background discussion 
of the role of eigenvalue analysis in quantum mechanics.

Consider the simple case of an electron moving in a potential energy field 
 at a momentum . The classical expression for the energy of the 

electron is

(EQ 155)

This formula assumes that we can specify exactly the position and momen-

tum of the electron, and Newton’s second law of motion, , 

assumes that these exactly-defined quantities vary continuously with time. 

At the beginning of the 20th century, experiments showed that this was not 
the case and guided the development of quantum mechanics in the 1920’s.

The results can be summed up by considering the case of electrons passing 
through slits or holes in a barrier (Figure 2). We have two slits in a barrier, 
and consider a beam of electrons arriving from the left. The barrier stops the 
electrons unless they pass through one of the openings. If we were to place a 
screen to the right of the barrier and count the number of electrons that hit 

λ a– j j ajk

k 1=

k j≠

N

∑≤ for some j 1 N,[ ]∈

V r( ) p mev=

Eclass
1

2me

--------- p p⋅( ) V r( )+=

td
dp ∇ V–=
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Matrix eigenvalue analysis: Applications in Quantum Mechanics
the screen at each location, we expect from classical mechanics to see peaks 
only directly behind each slit (left). But, in the experiment, the density of 
observed hits on the screen shows an interference pattern more to be 
expected from the behavior of waves (right). This pattern appears even if 
the flux of electrons is so small that only one electron passes through the 
system at a time; therefore, this behavior is inherent in the nature of the 
electron itself. Further experiments show that a particle moving at a 
momentum  has some of the properties of a wave with the wavelength 
given by the de Broglie relation  where  is Planck’s constant - a 
fundamental physical constant.

FIGURE 2. Passage of electrons through a hole in a barrier. At left, the 
expectation of classical mechanics. At right the experimentally-observed 

interference pattern for single-electron passage.

The prescribed procedure for obtaining the quantum mechanical description 
of the electron is to define a complex-valued wavefunction  such that 

p

λ h p⁄= h

Ψ r t,( )
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the probability that the electron is observed in a differential volume  
around the position r at time t is

(EQ 156)

Thus, the wavefunction must satisfy the normalization,

(EQ 157)

We now have the problem of finding a replacement for Newton’s second 
law of motion that describes the time-evolution of this wavefunction. While 
the particle has some of the properties of a wave, it does tend to be located 
in a compact region of space somewhere, outside of which the wavefunc-
tion decays to zero, as it must for (EQ 157) to be satisfied. Thus, we expect 
the wavefunction to look like a wavepacket (Figure 3).

FIGURE 3. The wavefunction of a particle has wavelike properties but is 
somewhat localized in space, thus resembling a wavepacket.

dV

Ψ r t,( ) 2dV

Ψ r t,( ) 2
Vd

ℜ 3

∫ 1=
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Matrix eigenvalue analysis: Applications in Quantum Mechanics
How do we obtain the momentum of a particle from its wavefunction? From 
de Broglie’s relation, , so we need to measure the wavelength. If the 
width of the region of observable non-zero  is , let  be the observed 
number of cycles of the wave in this region. As , we have an 
observed momentum of

(EQ 158)

But, it is clear that we cannot obtain a perfect observation of  since the 
amplitude goes to zero near the edges of the observation region, thus we 
have an observation error of at best . This yields an uncertainty in 
the observed momentum of , so that the uncertainties in the 
observed position and in the observed momentum satisfy the Heisenberg 
uncertainty relation,

(EQ 159)

We now consider how to perform this observation mathematically. Consider 
the case of a wavefunction with the spatial modulation,

(EQ 160)

The wavelength is specified exactly, , and so the momentum is 

known exactly, , . As , Heisenberg uncertainty 
requires  as indeed it is for this non-localized wavefunction. Note 
that this is somewhat of a hypothetical case, as particles like electrons have 
finite  and .

What mathematical operation could we define to extract the momentum 
value from such a state? We note that since the first derivative is

(EQ 161)

we see that  satisfies the equation,

p h λ⁄=

Ψ ∆x N

∆x Nλ=

p
Nh
∆x
-------≈

N

∆N 1±=

∆p h ∆x( )⁄≈

∆x∆p > ~h

Ψ x t,( ) eikx∝ kx( )cos i kx( )sin+=

λ 2π k⁄=

p hk= h h 2π( )⁄= ∆p 0=

∆x ∞=

∆x ∆p

xd
deikx

ike
ikx

i p h⁄( )eikx= =

e
ikx
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(EQ 162)

That is, the momentum is exacted from the wavefunction  by finding the 
eigenvalue of a differential linear momentum operator ,

(EQ 163)

This operator provides a mathematical tool to extract the momentum of a 
particle from its wavefunction, and provides a tie-in to eigenvalue analysis.

The general idea behind (non-relativistic) quantum mechanics is to write 
down first the classical expression for any observable quantity  that 
depends upon the position and momentum of the particle. In this expression, 
we replace each momentum component  with the corresponding momen-

tum operator  to obtain a differential operator . Generally, 

before we make the measurement there is some uncertainty in the value of 
, but our process of observation unavoidably changes the wavefunction of 

the particle during measurement. Let us say that we measure a value of  
equal to . Then, following the observation, the value of  is specified 
exactly, so that the wavefunction after measurement must be an eigenfunc-

tion of  satisfying

(EQ 164)

We shall find that constraints on the wavefunction after measurement such 

as  or boundary conditions on  may result in the measure-

ment process being able to return only one of a countable number of dis-
crete values .

Now, after the measurement the wavefunction will evolve with time accord-
ing to some unspecified dynamics until we have a new interaction with the 
surroundings to measure some new observable. We generally describe the 
dynamic evolution of the wavefunction with respect to observations of the 

ih
xd

de
ikx

– peikx=

Ψ
p̂

p̂ψ pΨ= p̂ ih
xd

d
–=

A r p,( )

pj

p̂j ih
xj∂
∂

–= Â

A

A

α A α=

Â

ÂΨ αΨ=

Ψ r t,( ) 2
Vd∫ 1= Ψ

α1 α2 …, ,
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Matrix eigenvalue analysis: Applications in Quantum Mechanics
energy. A particle with classical energy  has a wave-

function  governed by the time-dependent Schrödinger equation

(EQ 165)

The Hamiltonian operator  is obtained from  by making the canoni-

cal substitution for p, the corresponding momentum operator

(EQ 166)

For the case of a single electron in an external field the Hamiltonian is

(EQ 167)

and the wavefunction follows the partial differential equation

(EQ 168)

If the electron were interacting with nothing but the external potential , 
from classical mechanics its energy would be constant at a value . What is 
the corresponding situation for a wavefunction in quantum mechanics? In a 
stationary state of constant energy, the wavefunction can be factored as

(EQ 169)

Substitution into the time-dependent Schrödinger equation yields

(EQ 170)

Upon division by the product , we find the equation to be separable,

Eclass
1

2me
--------- p p⋅( ) V r( )+=

Ψ r t,( )

ĤΨ ih
t∂
∂Ψ

=

Ĥ Eclass

p̂ ih∇–=

Ĥ
1

2me

--------- ih∇–[ ] ih∇–[ ]⋅ V r( )+=

Ĥ
h

2

2me

--------- ∇ 2– V r( )+=

h
2

2me

--------- ∇ 2Ψ r t,( )– V r( )Ψ r t,( )+ ih
t∂
∂Ψ

=

V r( )
E

Ψ r t,( ) ψ r( )g t( )=

h
2

2me

--------- ∇ 2ψ[ ] g– V r( )ψg+ ihψ
td

dg
=

ψ r( )g t( )
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(EQ 171)

 must be a constant since the left function does not depend upon time and 
the right one does not depend upon position. Since the classical situation 
corresponds to constant energy, we identify  as the energy of the electron, 
that must satisfy the time-independent Schrödinger equation

(EQ 172)

When an electron is in a stationary energy state with  and 

, the time-dependent Schrödinger equation yields

(EQ 173)

Thus, although the observed energy in such a stationary state is constant, the 
wavefunction is not.

According to the rules of quantum mechanics, whenever we observe the energy of 

a particle, we obtain a value that satisfies the eigenvalue equation  for 

some  that satisfies all constraints on the allowable wavefunction.

While above we have explained the rules of quantum mechanics for a single 
particle, the approach is generally valid to systems of several interacting 
particles. Let a system of  particles have a wavefunction  

such that the probability of finding particle 1 within a volume  around 

, particle 2 within  around , etc. is . This 

must be normalized to

(EQ 174)

The total classical energy of the multi-particle system is

h
2

2me

--------- 1
ψ
---- ∇ 2ψ[ ]– V r( )+ ih

1
g
---

td
dg

E= =

E

E

h
2

2me

--------- ∇ 2ψ r( )– V r( )ψ r( )+ Ĥψ r( ) Eψ r( )= =

Ψ r t,( ) ψ r( )g t( )=

Ĥψ r( ) Eψ r( )=

ih
td

dg
Eg= ⇒ g t( ) e

iEt h⁄–
Et h⁄( )cos i Et h⁄( )sin–= =

Ĥψ Eψ=

ψ

N Ψ r1 r2 … rN, , ,( )

dr1

r1 dr2 r2 Ψ r1 r2 … rN, , ,( ) 2
dr1dr2…drN

… Ψ r1 r2 … rN, , ,( ) 2
dr1dr2…drN

ℜ 3

∫
ℜ 3

∫
ℜ 3

∫ 1=
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(EQ 175)

Making the replacement of momentum operators yields the time-indepen-
dent Schrödinger equation for the multi-particle system

(EQ 176)

Unfortunately, this is a  dimensional partial differential equation, and it 
is infeasible to solve it for the exact wavefunction, even numerically, for 

. As we see in Chapter 5, solving even 3-D PDE’s is numerically chal-
lenging, so that solving 30-D PDE’s when  is out of the question. 
This has necessitated the use of approximate methods for many-electron 
systems such as density function theory and the Hartree-Fock self-consis-
tent field theory that are beyond the scope of this text.

Energy states of a Hydrogen-like atom

Consider the case of an electron orbiting an atomic nucleus of atomic num-
ber . The potential field acting on the electron is spherically-symmetric, 

. Schrödinger’s equation, written in spherical coordinates, is

(EQ 177)

where

(EQ 178)

It may be shown analytically that the eigenfunctions satisfy

Eclass
pj pj⋅
2mj

-------------

j 1=

N

∑ V r1 r2 … rN, , ,( )+=

Ĥψ h
2

2mj

--------- ∇ j
2ψ

j 1=

N

∑– V r1 r2 … rN, , ,( )ψ r1 r2 … rN, , ,( )+ Eψ= =

3N

N 1>
N 10=

Z

V r( ) Zqe
2

r⁄–=

h
2

2me

--------- 1

r2
----

r∂
∂ r

2

r∂
∂ψ

 
  1

r2
----Λ

ˆ
ψ+

 
 
 

–
Zqe

2

r
---------ψ r θ φ, ,( )– Eψ r θ φ, ,( )=

Λ
ˆ
ψ

θ2

2

∂
∂ ψ θcot( )

θ∂
∂ψ 1

θsin( )2
------------------

φ2

2

∂
∂ ψ

+ +=
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(EQ 179)

where the indices are

(EQ 180)

If ,  is called an s-orbital; if , a p-orbital; if  a d-orbital; if 
, a f-orbital. These discrete allowable eigenvalues arise from the 

restriction that the wavefunction needs to be normalized to one.

The angular part of the eigenfunction is

(EQ 181)

where the  are associated Legendre functions,

(EQ 182)

These eigenfunctions,  are known as spherical harmonics, and 
prove useful in describing orientational distributions in spherical coordi-
nates because they satisfy the orthonormality relations

(EQ 183)

and thus we may write any “orientational” function as

ψ n l m, ,[ ]
r θ φ, ,( ) R

n l,[ ]
r( )Y l m,[ ] θ φ,( )=

n 0 1 2 …, , ,=

l 0 1 … n 1–, , ,=

m l– l– 1+ … 0 … l 1– l, , , , , ,[ ]∈

l 0= Ψ l 1= l 2=

l 3=

Y l m,[ ] θ φ,( ) 2l 1+( )
4π

------------------- l m–( )!
l m+( )!

----------------------
1 2⁄

Pl
m θcos( )eimϕ=

Pl
m θcos( )

Pl
m

w( ) 1 w
2–( )

m 2⁄

w
m

m

d

d Pl w( )= Pl
0

w( ) Pl w( )=

Pl w( ) 1

2l
l!

--------
w

l

l

d

d
w2 1–( )

l
=

Y
l m,[ ] θ φ,( )

Y
k n,[ ] θ φ,( )[ ] ∗ Y

l m,[ ] θ φ,( )[ ] θsin θd
0

2π

∫ 
 
 

φd
0

π

∫ δklδnm=
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(EQ 184)

These  have the eigenfunction properties

(EQ 185)

As  and , we can write

(EQ 186)

where

(EQ 187)

The radial eigenfunctions are

(EQ 188)

where the coefficients satisfy the recursion formula

(EQ 189)

and  is chosen such that  satisfies the normalization

f θ φ,( ) flmY
l m,[ ] θ φ,( )

m l–=

l

∑
l 0=

∞

∑=

flm Y
l m,[ ] θ φ,( )[ ] ∗ f θ φ,( ) θsin θd

0

2π

∫ 
 
 

φd
0

π

∫=

Y
l m,[ ] θ φ,( )

Λ
ˆ

Y
l m,[ ] θ φ,( ) l l 1+( )Y l m,[ ] θ φ,( )–=

e
imφ

mφ( )cos i mϕ( )sin+= Λ
ˆ

Y
l m,[ ] θ φ,( ) Λ

ˆ
Y

l m–,[ ] θ φ,( )=

Y l m,[ ] θ φ,( ) 2l 1+( )
4π

------------------- l m–( )!
l m+( )!
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1 2⁄
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m θcos( )Sm φ( )=

Sm φ( ) e
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
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=

R n l,[ ] r( )
Zqe

2
me
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2

--------------- r( )–
 
 
 

exp rl aj
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nh
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(EQ 190)

The energy eigenvalues depend upon the principal quantum number alone

(EQ 191)

Here, we have simply presented the analytical results; however, one could 
numerically compute these energy eigenstates by using the basis-set expan-
sion method described above. To compute the necessary integrals numeri-
cally, e.g. using triplequad in MATLAB, it may be helpful to use a 
renormalization to avoid division by zero,

(EQ 192)

Initial value problems: Gaussian Quadrature

We now prove the theorems for Gaussian quadrature. Consult the section in 
the text on Gaussian quadrature for definitions of any unfamiliar terms or 
notation.

Theorem GQ1: For the interval  and the weight function , 
there exists a set of orthogonal polynomials of leading coefficient one, 

, , such that  for . These polynomials 

are defined uniquely by the recursion formula

(EQ 193)

where

R
n l,[ ]

r( )
2
r

2
rd

0

∞

∫ 1=

E
n l m, ,[ ] Z

2
qe

4
me

h
2
n2

------------------–=

V r( )
Zqe

2

r ε+
-----------–= ε 0+→

a b,[ ] w x( ) 0≥

pj x( ) Π1 j∈ j 0 1 2 …, , ,= pj pk〈 | 〉 0= j k≠

pj 1+ x( ) x δj 1+–( )pj x( ) γj 1+
2 pj 1– x( )–=
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(EQ 194)

Proof:

We prove this theorem by induction; that is, we suppose that we have 
already constructed an orthogonal basis set  for  and then 

show that there exists a unique polynomial  that is orthogonal 

to all previous orthogonal polynomials,

(EQ 195)

and that satisfies the recursion formulas above. If we can show this, then 
starting from , we can construct the set of orthogonal poly-

nomials recursively one-by-one.

To do so, we first note that it is possible to write any polynomial of exact 
degree  and a leading coefficient of one as

(EQ 196)

for some set of scalar coefficients . We take the dot 

product of this equation with ,

(EQ 197)

Since we have assumed that the set  is mutually orthogonal,

(EQ 198)

p 1– x( ) 0= p0 x( ) 1=

δj 1+ xpj pj〈 | 〉 pj pj〈 | 〉⁄= j 1 2 …, ,=

γj 1+
2 0   j, 0=

pj pj〈 | 〉 pj 1– pj 1–〈 | 〉⁄   j, 1 2 …, ,=



=

p0 p1 … pj, , ,{ } Π j

pj 1+ Π1 j 1+∈

pj pk〈 | 〉 0= k 0 1 … j, , ,=

p0 x( ) 1 Π1 0∈=

j 1+

pj 1+ x( ) x δj 1+–( )pj x( ) cj 1– pj 1– x( ) cj 2– pj 2– x( ) … c0p0 x( )+ + + +=

pk x( ) Π1 k∈ k j 1+≤

δj 1+ cj 1– cj 2– … c0, , , ,{ }

pj x( )

pj 1+ pj〈 | 〉 xpj pj〈 | 〉 δj 1+ pj pj〈 | 〉– cj 1– pj 1– pj〈 | 〉 cj 2– pj 2– pj〈 | 〉+ +=

… c0 p0 pj〈 | 〉+ +

p0 p1 … pj, , ,{ }

pj 1– pj〈 | 〉 pj 2– pj〈 | 〉 … p0 pj〈 | 〉 0= = = =
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we can enforce orthogonality of  and  by setting

(EQ 199)

Next, we take the scalar product of  with , force this scalar 

product to be zero, and again invoke orthogonality of the set ,

(EQ 200)

If we can  then  is orthogonal to all of , 

, ...,  as well. This yields the recursion formula

(EQ 201)

that we put in the form of the theorem by writing

(EQ 202)

and taking the scalar product with ,

(EQ 203)

Using  and , we obtain

(EQ 204)

The two-term recursion formula for the orthogonal polynomials is then

(EQ 205)

where

(EQ 206)

pj 1+ x( ) pj x( )

pj 1+ pj〈 | 〉 xpj pj〈 | 〉 δj 1+ pj pj〈 | 〉– 0= = ⇒ δj 1+ xpj pj〈 | 〉 pj pj〈 | 〉⁄=

pj 1+ x( ) pj 1– x( )

p0 p1 … pj, , ,{ }

pj 1+ pj 1–〈 | 〉 xpj pj 1–〈 | 〉 cj 1– pj 1– pj 1–〈 | 〉+ 0= =

cj 1––  = 
xpj pj 1–〈 | 〉

pj 1– pj 1–〈 | 〉
--------------------------

cj 2– … c0 0= = = pj 1+ x( ) pj 2– x( )

pj 3– x( ) p0 x( )

pj 1+ x( ) x δj 1+–( )pj x( ) cj 1– pj 1– x( )+=

pj x( ) x δj–( )pj 1– x( ) cj 2– pj 2– x( )+=

pj x( )

pj pj〈 | 〉 xpj 1– pj〈 | 〉 δj pj 1– pj〈 | 〉– cj 2– pj 2– pj〈 | 〉+=

pj 1– pj〈 | 〉 pj 2– pj〈 | 〉 0= = xpj 1– pj〈 | 〉 xpj pj 1–〈 | 〉=

xpj pj 1–〈 | 〉 pj pj〈 | 〉=

pj 1+ x( ) x δj 1+–( )pj x( ) γj 1+
2

pj 1– x( )–=

δj 1+ xpj pj〈 | 〉 pj pj〈 | 〉⁄= γj 1+
2

cj 1––
pj pj〈 | 〉

pj 1– pj 1–〈 | 〉
---------------------------- 0≥= =
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Initial value problems: Gaussian Quadrature
To start the recursion properly, we set  and set .

Q.E.D.

Theorem GQ2: The N roots  of the orthogonal polynomial 

pN(x) are real, distinct and lie in (a,b), i.e. . The roots 

of pN(x) may be computed by the eigenvalue technique of Chapter 3.

Proof:

Let us assume that only  of the roots of  are distinct, and write the 

polynomial in its factored form as

(EQ 207)

Let us assume that we have ordered the roots such that the first  are 
real, have odd multiplicity (i.e.  are all odd), and lie within , 

and that the remaining  distinct roots either are of even multiplicity or 
lie outside of . Therefore, within ,  changes sign only at the 

first  roots.

Let us now define the polynomial

(EQ 208)

We then write the product  in factored form as

p 1– x( ) 0= γ0
2

0=

x1 x2 … xN, , ,{ }

a x1 x2 … xN b< < < < <

d N≤ pN x( )

pN x( ) x x1–( )
ν1 x x2–( )

ν2… x xd–( )
νd=

m d N≤ ≤
ν1 … νm, , a b,( )

d m–

a b,( ) a b,[ ] pN x( )

m

q x( ) x xk–( )
νk

k 1=

m

∏=

pN x( )q x( )
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(EQ 209)

We see that  has no real roots within  of odd multiplicity and 

therefore that  changes sign nowhere within . As , we 

then have

(EQ 210)

But, since we have constructed  to be orthogonal to every polynomial 

of degree less than , we see that the degree of  must be .  there-

fore has  distinct real roots within .

Q.E.D.

Theorem GQ3: The  matrix

(EQ 211)

is non-singular for any mutually distinct arguments .

Proof:

We present a proof by contradiction. Let us assume that  were singular. 

Then, there would exist a vector  such that 

pN x( )q x( ) x xk–( )
νd

k 1=

d

∏ x xk–( )
νk

k 1=

m

∏=

pN x( )q x( ) x xk–( )
2νk

k 1=

m

∏ x xk–( )
νk

k m 1+=

d

∏=

pN x( )q x( ) a b,( )

pN x( )q x( ) a b,[ ] w x( ) 0≥

pN q〈 | 〉 w x( )pN x( )q x( ) xd
a

b

∫ 0≠=

pN x( )

N q x( ) N pN x( )

N a b,( )

N N×

A

p0 x1( ) p0 x2( ) … p0 xN( )

p1 x1( ) p1 x2( ) … p1 xN( )

: : :

pN 1– x1( ) pN 1– x2( ) … pN 1– xN( )

=

x1 x2 … xN, , ,

A

c
T

c0 c1 … cN 1– 0≠=
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Initial value problems: Gaussian Quadrature
(EQ 212)

This yields the  conditions for the points , assumed distinct,

(EQ 213)

Thus, the polynomial

(EQ 214)

has at least  distinct roots; however, we see that it must be of degree  
or less. These two conditions can only be met if .

Let  be the largest index with . Then, we can write

(EQ 215)

Therefore, if  were singular, we could write

(EQ 216)

However, the left hand side is a polynomial of degree , but the right side is 
of a lesser degree. Therefore, this equation cannot be valid and we have 

c
T
A c0 c1 … cN 1–

p0 x1( ) p0 x2( ) … p0 xN( )

p1 x1( ) p1 x2( ) … p1 xN( )

: : :

pN 1– x1( ) pN 1– x2( ) … pN 1– xN( )

0= =

N x1 x2 … xN, , ,{ }

ckpk xj( )

k 0=

N 1–

∑ 0= j 1 2 … xN, , ,=

q x( ) cjpj x( )

j 0=

N 1–

∑=

N N 1–

q x( ) 0=

m cm 0≠

q x( ) 0 cmpm x( ) cjpj x( )

j 0=

m 1–

∑+= =

A

pm x( ) 1
cm

----- cjpj x( )

j 0=

m 1–

∑=

m
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introduced a contradiction. For any mutually distinct ,  must 

be non-singular.

Q.E.D.

Theorem GQ4: Let  be the N distinct roots of  in the 

open interval . Let  be the solution of the nonsingular set 

of linear equations

(EQ 217)

Then  for all , and for all ,

(EQ 218)

That is, if we place the support points at the zeros of the orthogonal polyno-
mial , then even though with only N support points, we can form an 

exact representation of polynomials up to degree , we obtain the exact 
value of the definite integral for any polynomials of degree  or less.

Placing the support points at the zeros of  provides optimal accuracy.

Proof:

We have shown in theorem GQ2 that the set of linear equations for the 
weights is nonsingular and has therefore a unique solution. We now con-
sider an arbitrary polynomial  that we write as

(EQ 219)

We next write  and ,

x1 x2 … xN, , ,{ } A

x1 x2 … xN, , ,{ } pN x( )

a b,( ) w1 w2 … wN, , ,{ }

pj xk( )wk

k 1=

N

∑
p0 p0〈 | 〉  if  j = 0,

0  if  j, 1 2 … N 1–, , ,=



=

wj 0> j 1 2 … N, , ,= p x( ) Π2N 1–∈

w x( )p x( ) xd
a

b

∫ wjp xj( )

j 1=

N

∑=

pN x( )

N 1–

2N 1–

pN x( )

p x( ) Π2N 1–∈

p x( ) pN x( )q x( ) r x( )+= q x( ) r x( ), ΠN 1–∈

q x( ) r x( )
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Initial value problems: Gaussian Quadrature
(EQ 220)

and evaluate the definite integral of ,

(EQ 221)

First, we see that since , from the orthogonality of 

,

(EQ 222)

Also, as , we can write

(EQ 223)

Again, from the orthogonality of ,

(EQ 224)

Therefore, we find that the definite integral of  is

(EQ 225)

Next, we note that at every root  of ,

(EQ 226)

q x( ) qkpk x( )

k 0=

N 1–

∑= r x( ) rkpk x( )

k 0=

N 1–

∑=

p x( ) Π2N 1–∈

w x( )p x( ) xd
a

b

∫ w x( ) pN x( )q x( ) r x( )+[ ] xd
a

b

∫ pN q〈 | 〉 w x( )r x( ) xd
a

b

∫+= =

q x( ) ΠN 1–∈

p0 x( ) p1 x( ) … pN x( ), , ,{ }

pN q〈 | 〉 qk pN pk〈 | 〉

k 0=

N 1–

∑ qk 0( )

k 0=

N 1–

∑ 0= = =

p0 x( ) 1=

w x( )r x( ) xd
a

b

∫ w x( )p0 x( )r x( ) xd
a

b

∫ p0 r〈 | 〉= =

p0 x( ) p1 x( ) … pN x( ), , ,{ }

p0 r〈 | 〉 rk p0 pk〈 | 〉

k 0=

N 1–

∑ rk p0 p0〈 | 〉δ0k[ ]

k 0=

N 1–

∑ r0 p0 p0〈 | 〉= = =

p x( ) Π2N 1–∈

w x( )p x( ) xd
a

b

∫ r0 p0 p0〈 | 〉=

x1 x2 … xN, , ,{ } pN x( )

p xj( ) pN xj( )q xj( ) r xj( )+ 0( )q xj( ) r xj( )+ r xj( )= = =
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so that

(EQ 227)

We now express each  as an expansion in orthogonal polynomials to 

write

(EQ 228)

Thus, if the set of weights are obtained by solving the linear system

(EQ 229)

then

(EQ 230)

for any .

For proof of the statements in the final paragraph of the theorem, the reader 
is referred to p. 153 of Stoer and Burlisch, Introduction to Numerical Anal-
ysis, Springer-Verlag, 1993.

Q.E.D.

wjp xj( )

j 1=

N

∑ wjr xj( )

j 1=

N

∑=

r xj( )

wjp xj( )

j 1=

N

∑ wj rkpk xj( )

k 0=

N 1–

∑
j 1=

N

∑ rk pk xj( )wj

j 1=

N

∑
k 0=

N 1–

∑= =

pk xj( )wj

j 1=

N

∑
p0 p0〈 | 〉  if  j = 0,

0  if  j, 1 2 … N 1–, , ,=



=

wjp xj( )

j 1=

N

∑ r0 p0 p0〈 | 〉 w x( )p x( ) xd
a

b

∫= =

p x( ) Π2N 1–∈
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Initial value problems: Parameter continuation and homotopy
Initial value problems: Parameter continuation 
and homotopy

In our previous discussion of nonlinear algebraic equations, we have seen 
how one can improve the robustness of Newton’s method by first starting 
from a set of parameters  for which the system  is easy to 

solve and then modify the parameters by small increments to obtain the 
final, desired solution with parameter vector . If we use as an initial 

guess at each step the result from the previous parameter value, we hope to 
start Newton’s method in the close vicinity of a solution where it performs 
more robustly. In this section, we see how to frame this homotopy method 
in a more robust and efficient form as an initial value problem.

We start with the parameter vector  and solve  for the solution 

. We then change the parameter vector from  to the final value  

over some path  where

(EQ 231)

The simplest choice is the linear path

(EQ 232)

We generate a solution path  where

(EQ 233)

As a first approach, we may think to integrate over ,

(EQ 234)

To obtain an expression for , we use the expansion for small ,

Θ0 f x Θ0;( ) 0=

Θ1

Θ0 f x Θ0;( ) 0=

xs0 Θ0 Θ1

Θ λ( )

Θ λ=0( ) Θ0= Θ λ=1( ) Θ1=

Θ λ( ) 1 λ–( )Θ0 λΘ1+=

xs λ( )

f xs λ( ) Θ λ( );( ) 0=

λ

xs 1( ) xs 0( )–
xsd

λd
-------

 
  λd

0

1

∫=

xsd λd⁄ λδ
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(EQ 235)

As along the solution path

(EQ 236)

this yields the equation for ,

(EQ 237)

We can compute (analytically or with finite differences) the partial deriva-
tive matrices for the function, and for a linear path

(EQ 238)

Solving for  yields

(EQ 239)

We see that this works fine as long as the Jacobian of the function, , is 

non-singular. Unfortunately, the Jacobian may well become singular, for 
example at a turning point where  diverges to infinity as the solution 

curve becomes vertical in  space (Figure 4.16 in the text). The homo-

topy method presented above will fail in such situations.

To avoid this problem, it is more robust to parameterize the solution curve 
not in terms of , but rather in terms of the arc-length  along this curve, a 
method known as arc-length continuation. As we move along the solution 

0 f xs λ λδ+( ) Θ λ λδ+( );( )=

0 f xs λ( ) Θ λ( );( )
xT∂
∂f
 
 

λd

dxs

 
  λδ

ΘT∂
∂f
 
 

λd
dΘ
 
  λδ+ +=

f xs λ λδ+( ) Θ λ λδ+( );( ) f xs λ( ) Θ λ( );( ) 0= =

xsd λd⁄

xT∂
∂f
 
 

λd

dxs

 
 

ΘT∂
∂f
 
 

λd
dΘ
 
 + 0=

Θd
λd

------- Θ1 Θ0–=

xsd λd⁄

λd

dxs

xT∂
∂f
 
 

1–

ΘT∂
∂f
 
 

λd
dΘ
 
 –=

x
T∂

∂f

xsd λd⁄

xs λ,( )

λ s
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Initial value problems: Parameter continuation and homotopy
curve in  space by an amount  and  (Figure 5), the change in the 

path length is

(EQ 240)

Dividing by  and letting  yields the following arc-length condi-
tion that must be satisfied by the functions  and ,

(EQ 241)

We now derive a simple predictor-corrector method for moving along this 
solution path, that being parameterized in terms of the arc-length, can step 
through turning points. As a predictor, we use the explicit Euler method to 
integrate from  to ,

(EQ 242)

We use the superscript [0] to denote that these are only our initial predictions 
of the new values that we will use later as initial guesses for a corrector 
stage calculation that ensures that we remain on the true solution path. To 
obtain the derivatives of the solution path variables with respect to arc-
length, we use the expansion,

(EQ 243)

As along the solution path,

(EQ 244)

xs λ,( ) xsδ λδ

sδ( )2 λδ( )2 xsδ xsδ⋅+=

sδ( )2 sδ 0→
xs s( ) λ s( )

xsd

sd
-------

xsd

sd
-------⋅ λd

sd
------

 
 

2

+ 1=

sk sk 1+ sk ∆s+=

xs
0[ ]

sk ∆s+( ) xs sk( )
xsd

sd
-------

sk
 
 
 

∆s+=

λ 0[ ]
sk ∆s+( ) λ sk( ) λd

sd
------

sk

 
 ∆s+=

0 f xs s sδ+( ) Θ s sδ+( );( )=

0 f xs s( ) Θ s( );( ) f∂
xT∂

--------
 
  xsd

sd
--------

 
  sδ f∂

ΘT∂
----------

 
  Θd

λd
-------

 
  λd

sd
------

 
  sδ+ +=

f xs s sδ+( ) Θ s sδ+( );( ) f xs s( ) Θ s( );( ) 0= =
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we have the linear system

(EQ 245)

subject to the quadratic constraint

(EQ 246)

We write this more compactly by defining the vectors

(EQ 247)

to obtain

(EQ 248)

To solve this equation, we generate some vector c such that c is not perpen-
dicular to ; a randomly-generated vector should work fine because it is 
highly unlikely to ever be perpendicular to . We can then remove the non-
linearity by replacing the unit length condition  with the equivalent 
normalization,

(EQ 249)

where we choose the plus or minus sign to enforce that we are moving in a 
consistent direction in  space,

(EQ 250)

f∂
xT∂

--------

sk
 
 
  xsd

sd
-------

 
  f∂

ΘT∂
--------- Θd

λd
-------

sk
 
 
  λd

sd
------

 
 + 0=

xsd

sd
-------

xsd

sd
-------⋅ λd

sd
------

 
 

2
+ 1=

z xs

λ
= z· xsd sd⁄

λd sd⁄
=

f∂
xT∂

--------

sk
 
 
  f∂

ΘT∂
--------- Θd

λd
-------

sk
 
 
 

z· 0= z· z·⋅ 1=

z·

z·

z· z·⋅ 1=

z·
v
v
-----±= cTv 1=

xs λ,( )

z·
xs sk( ) xs sk 1–( )–

λ sk( ) λ sk 1–( )–
⋅ 0≥
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Initial value problems: Parameter continuation and homotopy
We then solve for v from the linear system

(EQ 251)

The predictor estimate of  along the solution curve obtained after 

increasing the arc-length by an amount  is then

(EQ 252)

We next use this prediction as an initial guess in an iterative corrector stage 
that solves the nonlinear system

(EQ 253)

Applying Newton’s method to the first of (EQ 253) yields the iterative rule

(EQ 254)

where the updates must satisfy the N linear equations

(EQ 255)

Rather than apply Newton’s method to the second arc-length equation, we 

note that for small , any change in  that maintains a constant 

arc-length will be perpendicular to the vector  computed by the predictor. 
For small , we make the algorithm more efficient by reusing the deriva-

f∂
xT∂
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sk
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ΘT∂
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-------
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∆xs
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ΘT∂
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-------
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Beers, Numerical Methods in Chemical Engineering 61



62
tive matrices computed at the predictor stage, to yield an update equation 
that is solved quickly by LU factorization,

(EQ 256)

We stop the Newton iterations when we reach the solution curve,

(EQ 257)

We continue stepping along the curve by increasing the arc length until we 
reach .

This basic arc-length continuation method is the foundation of more 
advanced algorithms for examining the dependence of the solution of a non-
linear algebraic system upon the system parameters. A popular free-domain 
continuation software package is AUTO that also identifies bifurcation 
points, i.e. choices of parameters at which Jacobian of the function is singu-
lar at the solution. For more on bifurcation analysis, and its application to 
nonlinear dynamics, consult R. Seydel, Practical Bifurcation and Stability 
Analysis: From equilibrium to chaos. 2nd edition. Springer-Verlag, 1994.

Numerical optimization: The nonlinear simplex 
method

We now describe the simplex algorithm for finding the minimum of a cost 
function  step-by-step.

Step I. Form the initial simplex

From the initial guess , generate N additional points ,

f∂
xT∂

--------

sk
 
 
  f∂

ΘT∂
--------- Θd

λd
-------

sk
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------ z·T ------

∆xs
m[ ]

∆λ m[ ]

f xs
m[ ] sk 1+( ) Θ m[ ] sk 1+( );( )–

0
=

f xs
m[ ]

sk 1+( ) Θ m[ ]
sk 1+( );( ) δtol≤

λ 1=

F x( )

x
0[ ]

x
1[ ]

x
2[ ] … x

N[ ], , ,{ }
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Numerical optimization: The nonlinear simplex method
(EQ 258)

The  are chosen so that the  are of comparable magnitude.

Step II. Check for convergence

When the simplex tightly bounds the local minimum, the cost function val-
ues of all vertices will be nearly identical. The center of the simplex

(EQ 259)

is an acceptable estimate of the minimum if the following criterion is met 
for some small ,

(EQ 260)

If this criterion is satisfied, execution stops; else a new iteration begins at 
Step III.

Step III. Rank the vertices by their cost function values

Obtain the values of the following integers,

For example, if in the 2-D case , then

(EQ 261)

x j[ ] x 0[ ]
lje

j[ ]+= j 1 2 … N, , ,= em
j[ ] δjm=

lj F x
j[ ]( ) F x

0[ ]( )–

x
1

N 1+
------------- x j[ ]

j 0=

N

∑=

δtol 0>

1
N
---- F x j[ ]( ) F x 0[ ]( )–

2

j 0=

N

∑ δtol≤

M index of vertex with largest cost function=

M2 index of vertex with second-to-largest cost function=

m index of vertex with smallest cost function=

F x 2[ ]( ) F x 0[ ]( ) F x 1[ ]( )< <

M 1= M2 0= m 2=
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Step IV. Attempt to shift the simplex towards a region of lower cost function

If we move the simplex away from the vertex  of highest , we 
expect to move it towards . Thus, we compute the centroid of vertex ,

(EQ 262)

and “reflect”  respect to  using some scalar  (say, ),

(EQ 263)

FIGURE 4. Reflection step in simplex method

We now must decide whether replacing  with  will yield a simplex 
that is more likely to contain . Of course, without knowing , it is 

impossible to know if the new simplex will contain it; however, we consider 
the replacement acceptable if,

(EQ 264)

This condition is not met in the following cases:

x
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x
M[ ]

x
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xmin xmin

F x m[ ]( ) F x r( )( ) F x
M2[ ]

( )≤ ≤
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Numerical optimization: The nonlinear simplex method
Case 1. 

Here, we have been lucky and have moved the simplex in a direction that 
gives us a new “best” vertex. This suggests that we could do even better if 
we were to continue in this direction. We therefore find a point along the 
extension of the search direction,

(EQ 265)

where  (say ). Then, if , we form our new simplex 

by replacing  with . Otherwise, we already know that 

, so we replace  with . In either case, we have signif-
icantly improved the quality of the simplex.

FIGURE 5. The extension step of the simplex method when 

Case 2. 

In this case, we try to remedy the situation by contracting from whichever 

of  or  is lower in , using some  (say, ),
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(EQ 266)

 

FIGURE 6. Contraction is performed when 

We now identify two possibilities. First, if  and 

, the search direction that we had been using can reduce 
, but when doing the reflection, we just happened to step too far. If so, 

we replace  with  to form a new, improved simplex.

Alternatively, if  or , then it appears that 
our choice of a search direction was incorrect. When  is approximately 
linear over the simplex region, reflection should succeed in finding a point 
of lower cost function. Therefore, the appropriate action in this case is to 
make the simplex smaller, so that the curvature of  over the simplex is 
reduced. We thus do not accept any of the vertex substitutions suggested 
above, and execute instead step V of the algorithm.
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Numerical optimization: The nonlinear simplex method
Step V. If  or , reduce simplex size by gen-
eral contraction

If step IV fails, we reduce the simplex size, as the failure of the reflection, 
expansion, and contraction steps is due to the curvature of  over the 
region of the simplex. We thus perform a general contraction in which all 
vertices are contracted towards that of smallest cost function by halving the 
edge lengths. For each , 

(EQ 267)

FIGURE 7. The simplex method performs a general contraction if needed to 
make a local linear approximation of the cost function more valid.

After completion of step IV (and optionally of step V), the algorithm returns 
to step II to check again for convergence. When the simplex encloses , 

step IV is likely to fail, and the simplex will shrink by general contraction 
until it binds tightly the local minimum, at which point execution stops. In 
Matlab, the simplex method is invoked as the optimization toolkit routine 
fminsearch.
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Boundary value problems: Modeling a 

microfluidic H-filter using FEMLABTM

We now consider the use of FEMLAB, a software package (www.com-
sol.com) built on top of MATLAB, to solve a BVP using the finite element 
method. In this section, we use FEMLAB to model a microfluidic H-filter. 
Microfluidics is the study of systems that transport fluids in micron-sized 
channels, in which the small dimensions ensure laminar flow (unlike mac-
roscopic fluid systems that are nearly always turbulent). Microfluidic sys-
tems are of technological interest as microreactors and in a number of 
biotechnological applications such as “DNA on a chip”.

While microfluidic systems allow one to perform analyses on small vol-
umes of liquids (useful in DNA applications), the laminar flow characteris-
tics associated with their small size scale also yields interesting phenomena 
not significant on the macroscale. As an example, consider a H-filter for 
separating dilute components based on differences in the diffusivities 
(Figure 8). The dimensions of the channels are assumed to be on the micron 
scale in the plane of the figure, but very large in the out of plane dimension.
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Boundary value problems: Modeling a microfluidic H-filter using FEMLABTM
FIGURE 8. Microfluidic H-filter

Two fluids flow in on the left, one containing a pure fluid (upper left) and 
one (lower left) containing one or more species of suspended particles or 
dissolved solute. When these two streams meet, they flow from left to right 
across the middle of the filter in two neighboring layers, due to the laminar 
nature of the flow. In this section, the upper half is comprised initially of 
pure fluid and the bottom half initially contains solute and fluid at the con-
centrations found when entering the H-region at the lower left. As the fluid 
moves across the filter, the dilute components in the bottom half diffuse into 
the upper half, but since the flow is laminar, there is no turbulent mixing. 
Mass transfer occurs only through the relatively slow process of molecular 
diffusion. Thus, mixing will be significant only if the characteristic time for 

diffusion across the filter,  is smaller than the time necessary for 

the fluid to transverse the filer, .

If the bottom fluid stream contains two types of solutes of different sizes 
and diffusivities, e.g. large suspended particles and small molecules, the H-
filter section can be designed such that only the faster-diffusing solute has 

td W
2

D⁄∼

tres L V⁄∼
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sufficient time to mix. This microfluidic device thus can be used to separate 
solutes based on their relative diffusivities.

In this section, we demonstrate the use of FEMLAB to model the transfer of 
a component from one stream to the other in a H-filter using the finite ele-
ment method. We will go through the solution process step-by-step to see 
how the software is used.

1. Start the FEMLAB program

2. In the Model Navigator, press the button “Multiphysics”. You will see on 
the left a scroll window with various types of PDE’s. Select first “Incom-
pressible Navier-Stokes” and hit the >> button to add this equation to 
your model. You will see on the right at bottom, a list of the fields that this 
equation set models. They are u (x-direction velocity), v (y-direction veloc-
ity) and p (pressure). Next, scroll down the left window and select “Con-
vection-diffusion equation”, that adds another field u2 (the concentration 
of our dilute component). Hit OK to accept these model equations.

3. You are now shown a window with a grid in which you can specify the 
geometry of your 2-D BVP. We first modify the grid axes to meet the 
dimensions of our computational domain. Select from the pull-down menu 
“Options->Axes/Grid Settings”. Set “Xmin” to the value -2, “Xmax” to 12, 
“Ymin” to -5, and “Ymax” to 5. Then, hit the “Grid” button, unclick “Auto” 
and enter in the box “X” a value of 1 and a value of 1 in the “Y” box. Then, 
hit OK. 

4. Next, draw the H-filer, with a channel width of 1.0 in the vertical sections 
and 2.0 in the horizontal section. Click on the button in the upper left that 
has a rectangle (with no central dot) and then click on the grid at the point (-
1,4). Drag the cursor to the point (-4,0) and click again to add the left-most 
vertical channel. Next, add the central channel by hitting the same rectangle 
button at the upper-left, and start from (0,1) to (10,-1). Then, we add the 
right vertical channel by drawing a rectangle from (10,4) to (11,-4). 

5. We now fuse the three rectangles into a single computational domain to 
create a composite geometric object and remove the internal boundary parti-
tions. Select “Draw -> Create Composite Object...” and, holding the shift 
Beers, Numerical Methods in Chemical Engineering



Boundary value problems: Modeling a microfluidic H-filter using FEMLABTM
key, click on R1, R2, and R3 in the “object selection” window to highlight 
all three. Then, hit the “Apply” button to fuse all three into a single compos-
ite object and hit “OK” to close the menu.

6. Next, we modify some parameters that we will wish to vary later when 
studying the behavior of our model. First, we set the average velocity in the 
vertical channel. Select “Options -> Add/Edit Constants”, and in the 
“Name” field enter v_avg. Immediately below, enter a value of 0.01 and hit 
the “Set” button. Next, in the “Name” field type D (this is the diffusion con-
stant) and enter a value of 1e-3. Then, input the centerline x-coordinate of 
left vertical channel by setting xc1 to -0.5. Hit the “Apply” button and then 
“OK” to close the window.

7. We now start to specify the problem, starting first with the boundary con-
ditions. Select “Multiphysics” from the pull-down menu, and select 
“incompressible Navier-Stokes” to make this equation set active. Then, 
select “Boundary -> Boundary Mode” to begin entering the boundary con-
dition data for this equation set.

8. Double-click on the left-most vertical line and you will see a “Boundary 
Settings” window appear that shows that no-slip boundary conditions are 
selected for this boundary section. This is the default BC of the Navier-
Stokes equation. This is OK for all boundary sections except the inlet and 
outlet sections. Double-click on the outlet segment at the extreme upper-
right and select “straight-out” boundary conditions for this section. Do the 
same for the outlet at the lower-right. You should see that these sections are 
now of a different color to denote visually that they employ a different BC.

Next, set the inlet BC. First, start with the inlet at the lower-left. We know 
that the flow in this region has a positive y-direction velocity that is para-
bolic, reaches a maximum at the center-line and is zero at the boundaries. 
The x-direction velocity here is zero. Therefore, in the “Boundary Set-
tings” window, hit the top-button and type in the “Inflow, y velocity” win-
dow the expression:

2*v_avg*(1 - ( (x - xc1)/0.5 )^2)
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For the inlet at the upper-left, the velocity is in the negative y direction, and 
so in the “Inflow, y velocity” window enter

-2*v_avg*(1 - ( (x - xc1)/0.5 )^2)

This completes the specifications of the boundary conditions for the Navier-
Stokes equation.

9. Now, select “Multiphysics -> Convection-Diffusion Equation” to make 
this equation active. If we now click on the left-most vertical line, we find 
that the default is a zero-value Dirichlet BC. For all vertical lines (the solid 
walls of the vertical channels) and the upper and lower walls of the central 
horizontal channel, change the BC to “Neumann” type to make these walls 
impermeable (i.e. no flux in or out). The lines should change from solid to 
dashed.

Next, at the two outlets at the upper and lower right, also select “Neumann” 
BC, because after we have separated the stream, there is no further change 
in the concentration field as we move downstream (if we place the outlets 
far enough downstream). Therefore, the derivative of the concentration field 
in the y-direction will be zero at this point.

For the inlets, at the upper-left, retain the zero-value Dirichlet BC. For the 
lower-left inlet, set the inlet concentration to 1 by entering this value in the 
“r” window. We have now completed the specification of all boundary con-
ditions for this problem.

10. We next move to specifying the coefficients of the differential equation, 
selecting first “Multiphysics -> incompressible Navier Stokes”. Select 
“Subdomain -> Subdomain Mode” to begin entering the PDE coeffi-
cients. We want to use the same coefficients for all domains, so hold the 
shift-key and click on each subdomain (the two vertical and one horizontal 
rectangles) to highlight them all. Then select “Subdomain -> Subdomain 
Settings” to open the window to set the coefficients in the Navier-Stokes 
equation. We will not change anything, but if we wanted to change the vis-
cosity or density, or add a volumetric body force (e.g. from gravity) we 
could do so. Hit the “OK” button to exit.
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11. Next, select “Multiphysics -> Convection-Diffusion Equation” to 
enter the PDE coefficients for this equation. Again, highlight all boundaries 
and select “Subdomain -> Subdomain Settings”. We see a number of 
coefficients, and the form of the PDE is written in the window near the 
upper left corner. Since we want a steady-state solution, we set  to 0, set 

the coefficient  to be our user-defined diffusion constant by entering D in 
this window, and then remove the source term by setting  to zero. The row 
vector  contains the coefficients that multiply the first derivatives in this 
equation. These should take the values of the x and y direction velocities, so 
in the  window, enter u  v. Then, hit the “OK” button to accept the results.

12. We have now completely specified the geometry, boundary conditions, 
and the differential equations that define the BVP, and are ready to solve it 
using the finite element method. First, we select “File -> Save As -> 
Model.mat-file” and save our model as H_filter_FEMLAB.mat.

13. We next generate the mesh for the system. We select “Mesh -> Mesh 
Mode” to place an initial mesh. We then select “Mesh -> Refine Mesh” to 
add more nodes. Finally, add more nodes to where the vertical and horizon-
tal elements meet by highlighting each section with the mouse and then 
selecting “Mesh -> Refine Selected Elements”. Finally, select “Mesh -> 
Jiggle Mesh” to move the nodes so as to make the angles of each triangular 
more equal (this improves numerical performance). Select “File -> Save” 
to save the model with the generated mesh.

14. Finally, we solve the system by selecting “Solve -> Solve Problem”. 
This assembles the equation and uses a nonlinear algebraic solver to find the 
steady-state solution. Alternatively, we can select “Solve -> Parameters” 
to modify the method used to solve numerically the BVP. 

15. From the contour plot of the concentration field, we see that there is sig-
nificant mixing of the two streams along the two channels. If we modify the 
diffusion constant by selecting “Options -> Add/Edit Constants” and 
change the value of D to 1e-4, we can immediately compute a new solution 
by selecting “Solve -> Restart”, to renew the calculation using the previous 
result as an initial guess. We see that there remains considerable mixing at 
the exit due to the presence of a stagnation region where the fluid resides for 

da

c

f

β

β

Beers, Numerical Methods in Chemical Engineering 73



74
a comparatively long time. Also, we see that we should extend the outlet 
region further downstream so that the Neumann BC is rigorously valid; 
however, for simplicity, we do not make this change.

16. If we further reduce the value of D to 1e-5, we find oscillations in the 
solution. This is due to the convection-dominated nature of the problem, 
and the large local Peclet numbers. Essentially, we are solving the problem 
using an approach very similar to the central difference scheme (CDS), and 
there is no upwind differencing. We see from the colorbar that there are 
regions in which the concentration unphysically becomes negative in the 
numerical solution.

17. To avoid these spurious oscillations, we can add streamline diffusion by 
selecting “Solver Parameters -> Streamline Diffusion” (below we set 
“Scale” to 0.1). In addition, we can very effectively reduce the magnitude 
of the oscillations by refining the mesh at the interface along the middle of 
the horizontal channel, where the gradients are most steep. In “Mesh -> 
Mesh Mode”, we use the mouse to highlight the elements near the bound-
ary, and then select “Mesh -> Refine Selected Elements” to add more 
nodes in this region. After again selecting “Mesh -> Jiggle Mesh”, we 
select “Post -> Get Solution” to interpolate from the present solution the 
estimated values at the new nodes. We then solve the problem with the 
refined mesh by selecting “Solve -> Restart”. The oscillations are still 
present, but are now very small.

Boundary value problems: Modeling natural 

convection in FEMLABTM

We are all familiar with the concept that hot air rises. This is because fluids 
(generally) become less dense as their temperature raises, and so the down-
ward gravitational force per volume acting on hot fluid is less than that act-
ing on cold fluid. This process is known as natural convection. Here, we 

use FEMLABTM to model this phenomenon in a simple convection cell.
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Boundary value problems: Modeling natural convection in FEMLABTM
Consider a rectangular cell in 2-D, with solid walls enclosing a region of 
fluid (see figure below). The top and bottom walls are made of a solid that is 
a good thermal insulator. The right and left walls are made of a solid that is 
a good thermal conductor, and the temperatures of these walls are main-
tained at constant values. The temperature of the right wall, , is higher 

than that of the left wall, , so that we expect the velocity and temperature 

fields as shown in the figure below. Here, gravity acts in the -y direction.

 

FIGURE 9. Simple convection cell in which a horizontal temperature 
gradient induces through free-convection vertical flow in which the hot 

fluid at right rises and the cool fluid at left falls

To model this system, we will use a modification of the Navier-Stokes equa-
tions. Remember that these equations describe the flow behavior of a fluid 
that is Newtonian and that has a constant density in the flow. Here, of 
course, the density will change, but we expect that the magnitude of the 
density variations is small compared to the average value. Therefore, in our 
equations, we write the temperature-dependent density to be

(EQ 268)

T1

T0

ρ T( ) ρ ρβ T T–( )–=
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where  is a reference temperature and . The thermal 

expansion coefficient of the fluid is .

If we neglect the effect of small density variations in the convection term 
(the Boussinesq approximation), we have the modified Navier-Stokes 
equations of motion and continuity,

(EQ 269)

where g is the acceleration vector due to gravity, and the dynamic pressure 
is defined as , where  is the elevation in the gravitational field. 
The acceleration of a “particle” of fluid as it is convected through the sys-
tem is

(EQ 270)

In addition to these equations, we must also model the transport of thermal 
energy as heat through the system. The temperature field for this problem is 
governed by the PDE

(EQ 271)

where  is the specific heat of the fluid,  is the thermal conductivity of 
the fluid, and the volumetric rate at which heat is generated due to the vis-
cous dissipation of energy (remember viscosity is like internal friction 
within the fluid) is

(EQ 272)

For slow flows, as in this example, this term, which is second-order in the 
velocity gradients, may be neglected (the free convection limit).
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In addition to these PDE’s, we need to specify the boundary conditions. For 
all solid walls, we employ no-slip boundary conditions. For the temperature 
field, we impose Dirichlet BC’s of known temperature values at the left and 
right walls, and at the top and bottom insulating walls we use the Neumann 
BC’s that the component of the temperature gradient normal to the wall is 
zero.

We can decrease the number of unknowns in the problem statement by 
defining a reference length , e.g. the distance between the plates, and a 

reference velocity . Using these values, we can define the dimensionless 

quantities

(EQ 273)

in which case the governing equations take the dimensionless forms

(EQ 274)

The only two free dimensionless parameters are the Prandtl number

(EQ 275)

and the Grashof number

(EQ 276)
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Dṽ
Dt̃
------- ∇̃ P̃– Pr( )∇̃

2
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We see that the Prandtl number is a characteristic of the fluid. Typical val-
ues at room temperature are

(EQ 277)

The Grashof number is a dimensionless measure of the ability of the impor-
tance of the temperature gradient on the flow behavior.

To solve this problem numerically using FEMLABTM, choose in the initial 
Multiphysics menu an incompressible Navier-Stokes mode and a con-
vection-diffusion mode for the field T. Draw a rectangular domain with 
lower-left corner (0,0) and upper-right corner (1,5). Taking  to be the hor-

izontal distance between plates, we see that this choice of a distance of 1 is 
appropriate for solving the dimensionless form of the equations.

Next, switch to Boundary Mode, and accept the default no-slip BC’s for 
the Navier-Stokes’ mode on each wall. For the convection-diffusion mode, 
select the Neumann BC for the top and bottom walls. You switch between 
modes by selecting the appropriate one under the Multiphysics pull-down 
menu. For the left wall, the default Dirichlet BC that T = 0 is appropriate 
for the dimensionless temperature field. For the right wall, we want to 
switch r = 1 to set in the Dirichlet BC T = 1 (see the notation at the top of 
the window for the meaning of each coefficient in the Neumann and 
Dirichlet BC’s).

Now that the boundary conditions are set, we move to the specification of 
the governing equations. First, in the Options->Add/Edit constants tab, 
define values of the parameters Pr = 1 and Gr = 0. Then, in the Navier-
Stokes mode, we set the value of the viscosity to Pr (its “value” in the 
dimensionless equations), and for the y-component of the body force, enter 
Gr*Pr^2*(T-0.5). Next, we switch to the convection-diffusion mode. In the 
top of the Subdomain Settings window, we see the form of this differen-
tial equation. We get the correct form of the equation for the dimensionless 
temperature field by setting the parameters: 

da = 1, c = 1,  = [u v], f = 0

Prair 0.7= Prwater 6.0= PrHg metal 0.029=

l0

β
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Probability theory and stochastic simulation: Statistical mechanics and the Boltzmann 
Next, form an appropriate finite element mesh for the domain, and use the 
stationary linear solver to find the steady-state solution. Here, because Gr = 
0, there is no flow. Then, set Gr = 1e-3 to induce a circulation pattern due to 
free convection. If the stationary non-linear solver has problems converg-
ing, you might try switching to the time-dependent solver (the fldaspk 
option with an end time of 10 should get you to steady-state).

Probability theory and stochastic simulation: 
Statistical mechanics and the Boltzmann 
distribution

In chapter 7 of the text, we apply probability theory to study physical phe-
nomena using statistical mechanics, the microscopic theory underpinning 
classical thermodynamics. Here, we provide a cursory introduction to this 
vital subject including a derivation of the Boltzmann distribution.

Let us say that we have a physical system whose state is defined by a vector 
of parameters q. We assume that each component of q takes one of a count-
able number of discrete values (as happens in quantum mechanics). The 
total energy of the system is . Let  be the total number of 

microstates q of the system that have an energy value ,

(EQ 278)

We define the entropy of the system as

(EQ 279)

with  being the Boltzmann constant (the ideal gas constant divided by 

Avagadro’s number).

E q( ) Ωs E( )

E q( ) E=

Ωs E( ) δE q( ) E,

q

∑= δE q( ) E,
1  if E q( ) = E,
0  if E q( ) E≠,




=

S N V E, ,( ) kb Ωs E( )ln=
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At equilibrium for an isolated system (constant energy E, constant volume 
V, constant number of atoms N), all microstates are equally likely to be 
observed.

What is the value of some property  that we observe in this case?

The number of microstates that have energy E and a value  is

(EQ 280)

We define the corresponding A-dependent entropy

(EQ 281)

Let  be the value of A that maximizes , and thus also maxi-

mizes . Typically, for a large microscopic system containing as 

many as a mole, , of atoms, we have

(EQ 282)

for any  in which we do not have .

As an example of this property, consider a system in which an ideal gas of n 
non-interacting particles is enclosed in a container of fixed volume V. Let us 
partition this system into two halves of equal volume , and let the num-
ber of atoms in each half be  and  (Figure 10). 

A q( )

A q( ) A=

Ωs E A,( ) δE q( ) E, δA q( ) A,

q
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Ωs E Amax,( ) Ωs E A',( )»

A' A' Amax⁄ 1≈

V 2⁄
n1 n2 n n1–=
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FIGURE 10. Example of a box containing ideal gas particles, counting 
numbers of particles on each half of the box

We want to compute the average of  in the thermodynamic limit as 

. Since each atom has an equal chance of being in either half at the 
time of measurement, the probability of observing a particular value of  is 

given by the binomial distribution

(EQ 283)

For fixed n, let the fraction of atoms found in the first half of the system be 
. The probability distribution of observing a particular value of 

this quantity, for fixed n, is then

(EQ 284)

Using the gamma function

(EQ 285)

that satisfies the property

(EQ 286)
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we write the distribution for , treated as a continuous variable, as

(EQ 287)

so that

(EQ 288)

Figure 11 plots this distribution of  for various values of . We see that as 

 increases, this distribution becomes more tightly peaked around the max-
imum value at . Thus, in the thermodynamic limit, , we 

essentially only observe the maximum value and , .
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FIGURE 11. Distribution of the fraction  of  non-interacting atoms 

observed in a particular half of an enclosed domain. As  increases, the 
distribution becomes progressively more peaked around the maximum 
value at . This value is effectively the only one observed in the 

thermodynamic limit .

In general, the expectation value of A in the thermodynamic limit is (to a 
close approximation) , as at a constant value of E,

(EQ 289)

If whenever we do not have , , then

ϕ1 n

n

ϕ1 1 2⁄=

n ∞→

Amax

A〈 〉

A q( )δE q( ) E, δA q( ) A,

q

∑

δE q( ) E, δA q( ) A,

q

∑
------------------------------------------------------

AmaxΩs E Amax,( ) A q( )Ωs E A,( )
A q( ) Amax≠
∑+

Ωs E Amax,( ) Ωs E A,( )
A q( ) Amax≠
∑+

-------------------------------------------------------------------------------------------= =

A' Amax⁄ 1≈ Ωs E Amax,( ) Ωs E A',( )»
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(EQ 290)

Thus, we observe the second law of thermodynamics, that in an isolated 
system, the properties change so as to maximize entropy. For such a isolated 
(microcanonical) system, every microstate  such that  is equally 
probable to be observed.

We now ask, what is the probability distribution  of microstates when 
the system is no longer isolated, but rather exchanges heat with its sur-
roundings such that the temperature is constant at a value T?

We still assume that the system remains at a constant volume V and a con-
stant number of atoms N. Thus, this situation is called the NVT, or canoni-
cal, ensemble of microstates. To treat this situation, we couple the system to 
a thermal bath, such that the bath and the system exchange heat continually 
and are always at the same temperature (Figure 12). But, the only exchange 
between the two is heat, there is no transfer of mass or change in volume of 
the system or of the bath. The total composite system, the system of interest 
and the bath, is then isolated so that they cannot exchange any energy, mass, 
or volume with the outside.

A〈 〉 Amax

1
A q( )
Amax

-----------
Ωs E A,( )

Ωs E Amax,( )
-----------------------------

A q( ) Amax≠
∑+

1
Ωs E A,( )

Ωs E Amax,( )
-----------------------------

A q( ) Amax≠
∑+

------------------------------------------------------------------------

 
 
 
 
 
 
 

Amax≈=

q E q( ) E=

p q( )
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Probability theory and stochastic simulation: Statistical mechanics and the Boltzmann 
FIGURE 12. Composite system with thermal bath for NVT ensemble

Let the composite system have a total energy , held constant. For a sys-

tem microstate of energy , the bath must then have an energy 
. Let  be the number of microstates of the bath with this 

energy. For each of these  number of bath microstates, there are a 

number  of possible microstates of the system, so that the total num-

ber of microscopic ways of arranging the system with an energy E of the 
system and an energy  of the bath is

(EQ 291)

Taking the log of both sides and multiplying by , we obtain the total 

entropy of the isolated composite system and bath,

ET

E q( ) E=

ET E– ΩB ET E–( )

ΩB ET E–( )

Ωs E( )

ET E–

Ω E NT VT ET, , ,( ) Ωs E( ) ΩB ET E–( )×=

kb
Beers, Numerical Methods in Chemical Engineering 85



86
(EQ 292)

 and  and the number of atoms and volume of the bath and the corre-

sponding values for the total composite system are  and 

. By the second law of thermodynamics, heat is transferred 

between the system and bath so as to maximize the total entropy of the iso-
lated composite system. When the bath is much larger than the system, 

, and we say that the system evolves such as to 

maximize the number of microstates of the bath . Thus, the distri-

bution of the system microstates is

(EQ 293)

Since for a very large bath, , we use the expansion at ,

(EQ 294)

Now, using our definition of entropy, and the result of classical thermody-

namics , we have

(EQ 295)

and

(EQ 296)

Substituting this result into  yields the famous Boltzmann distribution

S E NT VT ET, , ,( ) S N V E, ,( ) SB NB VB E ET–, ,( )+=

NB VB

NT N NB+=

VT V VB+=

SB NB VB E ET–, ,( ) S N V E, ,( )»

ΩB ET E–( )

p q( )
ΩB ET E q( )–( )

ΩB ET E q( )–( )
q

∑
---------------------------------------------=

ET E q( )» E q( ) 0=

ΩBln ET E q( )–( ) Ωln B ET( ) E q( )
E∂
∂ Ωln B E( )

ET

×–≈

S∂ E∂⁄( )
V N, T

1–
=

E∂
∂ Ωln B E( )

ET

1
kb

----
E∂
∂S
 
 

ET

1
kbT
--------= =

ΩBln ET E q( )–( ) Ωln B ET( )
E q( )
kbT

-----------–≈

p q( )
Beers, Numerical Methods in Chemical Engineering



Statistics and parameter estimation: Corrective treatment of (near) singular XTX
(EQ 297)

For a more detailed description of this subject, and a derivation of probabil-
ity distributions in other ensembles, consult D.A. McQuarrie, Statistical 
Mechanics, Harper-Collins, 1973 and D. Frenkel and B. Smit, Understand-
ing Molecular Simulation, 2nd. ed., Academic Press, 2002.

Statistics and parameter estimation: Corrective 

treatment of (near) singular XTX

We consider here an example of least squares analysis in which singularity 

of XTX is nearly guaranteed. Often, in business and engineering, one wishes 
to improve the performance of a system for which it is difficult to derive a 
theoretical model. In Response Surface Methodology (RSM), one fits a 
general (e.g. polynomial) model to the data, and then optimizes this model 
to generate the best design of the system. For a system with the n known 
system parameters , we wish to fit the polynomial model

(EQ 298)

We define the vector of predictor variables

(EQ 299)

and the parameter vector

(EQ 300)

p q( )

E q( )
kbT

-----------–exp

E q( )
kbT

-----------–exp

q

∑
--------------------------------------=

α1 α2 … αn, , ,{ }

y c0 cjα j

j 1=

n

∑ cjlα jα l

l 1=

n

∑
j 1=

n

∑ …+ + +=

x 1 α1 α2 … αn α1
2( ) α1α2( ) … α1αn( ) α2α1( ) … αn

2( ) …=

θ c0 c1 c2 … cn c11 c12 … c1n c21 … cnn …
T

=
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Truncation of this polynomial yields a linear least squares problem that can 
be solved, in principle, using the methods discussed above. In practice, as 

one fits more and more parameters, XTX often becomes singular. We 
describe here how one may drop the unnecessary, or unpredictable, parame-

ters from the model using eigenvalue analysis of XTX.

With , we note that the covariance matrix of  is

(EQ 301)

and that the least squares parameter estimate is

(EQ 302)

The presence of (near) zero eigenvalues of XTX makes the variance of the 
least squares parameter estimate very large or infinite. In this example, 
these (near) zero eigenvalues are due to the presence of parameters in our 
model that cannot be estimated accurately given the data at hand. We would 
do better if we did not attempt to estimate these parameters at all (thus 
obtaining a smaller covariance for the subset of parameters that we do have 
sufficient data to estimate). To do so, we form the pseudo-inverse of Λ, 
where for some chosen ,

(EQ 303)

This modification discards any attempt to estimate the component of  in 

the eigenvector direction  if  is too small. In RSM, we first consider 

fitting a polynomial with a very large set of parameters; however, a signifi-
cant number of these will probably not be able to be estimated with suffi-
cient accuracy from the data at hand. From eigenvalue analysis, we identify 

X
T
X VΛV

T
= θ

cov θ( ) σ2
VΛ 1–

V
T=

θLS VΛ 1– VTXTy λ j
1– v j[ ] XTy( )⋅[ ] v j[ ]

j 1=

P

∑= =

λmin 0≥

Λ
˜ 1–

λ̃1
1–

λ̃2
1–

.

λ̃M 1+
1–

= λ̃ j
1– λ j

1– λ j λmin>,

0 λ j λmin≤,



=

θ

v
j[ ] λ j
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Statistics and parameter estimation: Corrective treatment of (near) singular XTX
and discard the linear combinations of parameters that we cannot fit, and 
write the best fit of parameters as

(EQ 304)

Since we will want to use this model in an optimization to find the “best” 
design of the system, we wish to decrease the number of independent model 
variables by retaining only the linear combinations of predictor variables 
that correspond to the significant eigenvectors (those that account for most 
of the information content in the data set). If the eigenvalues are ordered by 
decreasing magnitude, with

(EQ 305)

then

(EQ 306)

We streamline the predicting of responses by discarding those linear combi-

nations of predictor variables outside of  that correspond 
to the linear combinations of parameters that we have not estimated. As the 
eigenvectors are orthonormal, the transformed predictor vector is

 (EQ 307)

The reduced model is

(EQ 308)

where the parameters are computed by linear least squares,

θM λ̃ j
1–

v j[ ]
X

Ty( )⋅[ ] v j[ ]

j 1=

P

∑=

λ1 λ2 … λQ λmin>≥ ≥ ≥ λmin λQ+1 … λP≥ ≥ ≥

θM λ j
1–

v
j[ ]

X
T
y( )⋅[ ] v j[ ]

j 1=

Q

∑=

span v
1[ ] … v

Q[ ], ,{ }

z k[ ]
v 1[ ] x k[ ]⋅( ) v 2[ ] x k[ ]⋅( ) … v Q[ ] x k[ ]⋅( ) ℜ Q∈=

ŷ
k[ ] γ1z1

k[ ] γ2z2
k[ ] … γpzp

k[ ]+ + +=
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(EQ 309)

We now find the optimal design by varying the original set of parameters 
, and for each choice of these parameters, compute the 

reduced predictor vector z and the corresponding value of the response y 
until a set  yielding an optimal response is identified.

Statistics and parameter estimation: Additional 
results based on frequentist arguments

In the Bayesian paradigm, statistical conclusions are based on the posterior 
density , treating  and σ as random variables without any explicit 
reference to their deterministic “true” values. In this section, we discuss 
some results from analysis based on frequentist reasoning; that is, we ask:

What are the statistical properties our of estimates if we were to redo the 
same set of experiments over again many times?

Of course, since we can only base our conclusions on the data that we have 
collected, properties based on repeating the same set of experiments again 
some time(s) in the future do not affect the procedure that we follow in 
making estimates or testing hypotheses. They can, however, provide addi-
tional insight into the long-term performance of our estimation techniques. 
We would like, if we were to continue collecting data an infinitum, that our 
estimates eventually would converge to the “true” values.

Let  be some statistic extracted from the response data of a set of exper-
iments. For example,  could be the least squares parameter estimate 

 or it could be the sample variance . Each time we redo the set of 

γ Z
T
Z( )

1–
Z

Ty= Z

--- z
1[ ]

---

--- z
2[ ]

---

:

--- z p[ ]
---

=

α1 α2 … αn, , ,{ }

α1 α2 … αn, , ,{ }

p θ σ y,( ) θ

z y( )
z y( )

θLS y( ) s
2

y( )
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Statistics and parameter estimation: Additional results based on frequentist arguments
experiments and observe a different set  of responses due to random 

error, we compute a different statistic  from the response data. 
In frequentist analysis, we are concerned with the expectation of this statis-
tic over very many repeats of the set of experiments,

(EQ 310)

In our frequentist analysis, we postulate that the model, if a valid descriptor 
of the response that follows from specified predictor values, has a “true” set 
of parameters, to which the random error is added,

(EQ 311)

Of particular concern is the question, if we were to continue collecting data 
by repeating the same set of experiments, would our estimates converge to 
the “true” values? That is, when is it the case that

(EQ 312)

The importance of the zero-mean Gauss-Markov condition

Among the Gauss-Markov conditions, the most important one is the 
requirement that the means of the errors in each experiment are zero, 

. Let us consider the particular case of a linear model,

(EQ 313)

Let us say that we repeat this set of experiments many times, using the same 
design matrix X but we obtain different response vectors y due to the ran-
domness of ε. The averaged response over many repeated data sets is 

(EQ 314)

y
n〈 〉

z
n〈 〉

z y
n〈 〉( )=

Efreq z[ ] 1
Nrpt

-------- z y n〈 〉( )

n 1=

Nrpt

∑Nrpt ∞→
lim=

y f x θ(true);( ) ε+=

Efreq θLS[ ] θ (true)=

E ε( ) 0=

y Xθ true( ) ε+=

Efreq y( ) Efreq Xθ true( ) ε+( ) Xθ true( ) E ε( )+ Xθ true( )= = =
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Thus, the random error “averages out” if . Due to the random error, 
each set of experiments yields a different least squares estimate

(EQ 315)

The averaged  over these many repeated data sets tends towards

(EQ 316)

As long as , the least squares estimate  is an unbiased estimate 

of ; that is, .

The sample variance is an unbiased estimate of the error variance for a 
linear model

Again, let us assume that the Gauss-Markov conditions hold,

(EQ 317)

After fitting the coefficients of a linear model, we have the following infor-

mation available to estimate :

1. The design matrix  and the measured response vector y

2. The least squares parameter estimate, 

3. The vector of model predictions using 

(EQ 318)

E ε( ) 0=

θLS XTX( )
1–
XTy=

θLS

Efreq θLS( ) E XTX( )
1–
XTy[ ] XTX( )

1–
XTE y( ) XTX( )

1–
XT Xθ true( )( )= = =

Efreq θLS( ) Iθ true( ) θ true( )= =

E ε( ) 0= θLS

θ true( )
Efreq θLS( ) θ true( )

=

E ε k[ ]( ) 0= cov ε k[ ] ε j[ ],( ) δkjσ
2=

σ2

X

θLS X
T
X( )

1–
X

T
y=

θLS

ŷ θLS( )
ŷ 1[ ] θLS( )

:

ŷ
N[ ] θLS( )

XθLS= =
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Statistics and parameter estimation: Additional results based on frequentist arguments
4. The residual errors

(EQ 319)

Note that since ,  is not the same as the model prediction 

obtained with the “true” parameters . Therefore, the residual 
errors that we know are not equal to the random errors added to the “true” 
model (that remain unknown).

(EQ 320)

We now examine how the known e is related to the unknown ε for a linear 
model, where

(EQ 321)

In the first equation, we substitute for ,

(EQ 322)

We simplify this equation by defining the matrix

(EQ 323)

to obtain

(EQ 324)

 is a real, symmetric matrix, so that all of its eigenvalues are real and its 
eigenvectors form a complete orthonormal basis set.

Using , we have

(EQ 325)

We next note that,

e y y θLS( )–=

θLS θ true( )≠ ŷ
k[ ] θLS( )

ŷ
k[ ] θ true( )( )

ε k[ ] e k[ ]≠ ε k[ ] y k[ ] ŷ k[ ] θ true( )( )–≡ e k[ ] y k[ ] ŷ k[ ] θLS( )–≡

e y XθLS–= ε y Xθ true( )–=

θLS

e y XθLS– y X XTX( )
1–
XTy[ ]– I X XTX( )

1–
XT–[ ] y= = =

A I X X
T
X( )

1–
X

T–=

e Ay=

A

y Xθ true( ) ε+=

e Ay A Xθ true( ) ε+[ ] AXθ true( )
Aε+= = =
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(EQ 326)

so that

(EQ 327)

First, note that since , a simple check to see whether our 
assumption  is violated is to examine whether . That is, 
when making plots of the residual errors against the response vector or any 
of the predictors, we should see no trend in the plot, but rather find scattered 
errors around zero with no apparent widening or narrowing. 

This relationship  provides a method to estimate the variance  of 
the measurement error (unknown) from the vector of residual errors 
(known). We write the sum of squared residual errors, evaluated at , as,

(EQ 328)

Using the relation , we obtain

(EQ 329)

As  is symmetric,

(EQ 330)

we have

(EQ 331)

We have shown that , so that the second term is zero. Thus, A is 

idempotent, , and we have,

AX I X X
T
X( )

1–
X

T–[ ]X X X X
T
X( )

1–
X

T
X( )– X X– 0= = = =

AXθ true( ) 0= e Aε=

E e( ) AE ε( )=

E ε( ) 0= E ε( ) 0=

e Aε= σ2
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S θLS( ) y
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2
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N

∑ e
k[ ]( )

2
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N

∑ eTe= = =

e Aε=
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A I X X
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Statistics and parameter estimation: Additional results based on frequentist arguments
(EQ 332)

We now take the frequentist expectation of this equation,

(EQ 333)

Using the Gauss-Markov assumption , we have

(EQ 334)

It is proved below that for an experimental design with N experiments and P 
fitted parameters, 

(EQ 335)

so that the sample variance , an unbiased estimate of the random error 

variance , is

(EQ 336)

While we have derived this relation for a linear model, we can extend this as 
a definition of the sample variance to nonlinear models as well.

Proof that :
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Beers, Numerical Methods in Chemical Engineering 95



96
To show that , we write A explicitly

(EQ 337)

so that

(EQ 338)

As B is idempotent,

(EQ 339)

and symmetric positive-semidefinite,

(EQ 340)

all eigenvalues of B must take a value of either 0 or 1, since if

(EQ 341)

and we write an arbitrary vector v as

(EQ 342)

then

(EQ 343)

Now, as , for all v, , so that for every eigenvalue of B,
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Statistics and parameter estimation: Additional results based on frequentist arguments
(EQ 344)

As the trace of a matrix equals the sum of its eigenvalues,

(EQ 345)

 equals the number of non-zero eigenvalues of .  is 
determined completely by the design matrix of dimension . Therefore, 
the number of non-zero eigenvalues of B equals the number of linearly inde-
pendent columns of the design matrix. Assuming that no two of the P col-
umns of X are dependent and that ; that is, there are at least as many 
experiments as parameters to be fitted,

(EQ 346)

and

(EQ 347)

Q.E.D.

λ j λ j
2= ⇒ λ j 0 or 1=

tr B( ) λ1 λ2 … λN+ + +=

tr B( ) B B X X
T
X( )

1–
X

T
=

N P×

N P≥

tr B( ) P dim θ( )= =

tr A( ) N dim θ( )–=
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